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Chapter 1 — General Information

1-1 Introduction 
The VNA Master User Guide is part of a set of manuals that cover all of the instrument 
functions and their use. This manual covers the instrument overview, system functions, and 
other common features, along with a brief guide to basic measurement concepts and setups. 
Most instrument operations and modes are covered in specific measurement guides as listed 
below.

Additional Documentation 
Document Part Number Description (Required Option)
10100-00065 Important Product Information, Compliance, and Safety Notices
10580-00289 Vector Network Analyzer Measurement Guide

10580-00349

Spectrum Analyzer Measurement Guide
PIM Hunting
Bias-Tee (Option 10)
IQ Waveform Capture (Option 24)
Interference Analyzer (Option 25)
Channel Scanner (Option 27)
Zero-Span IF Output (Option 89)
Gated Sweep (Option 90)
Coverage Mapping (Option 431)

10580-00232 Signal Generators Measurement Guide
Vector Signal Generator (Option 23)

10580-00234

3GPP Signal Analyzer Measurement Guide
GSM/GPRS/EDGE Measurements (Option 880)
W-CDMA/HSPA+ Measurements (Option 881)
TD-SCDMA/HSPA+ Measurements (Option 882)
LTE/LTE-A FDD/TDD Measurements (Option 883)

10580-00235 3GPP2 Signal Analyzer Measurement Guide
CDMA/EV-DO Measurements (Option 884)

10580-00236 WiMAX Signal Analyzer Measurement Guide
WiMAX Fixed/Mobile Measurements (Option 885)

10580-00240
Power Meter Measurement Guide
Internal Power Meter
High-Accuracy Power Meter (Option 19)

10580-00280 PIM Master User Guide
PIM Analyzer (requires PIM Master MW82xxA)

10580-00367 Programming Manual
10580-00368 Maintenance Manual

11410-00698 BTS Master Technical Data Sheet
Performance Specifications, Instrument Options and Accessories
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Read the Handheld Instruments Product Information, Compliance, and Safety Guide 
(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the 
equipment. For additional information and literature covering your product, visit the product 
page of your instrument and select the Library tab:

http://www.anritsu.com/en-US/test-measurement/products/ms2026c   

http://www.anritsu.com/en-US/test-measurement/products/ms2027c

http://www.anritsu.com/en-US/test-measurement/products/ms2028c

http://www.anritsu.com/en-US/test-measurement/products/ms2036c

http://www.anritsu.com/en-US/test-measurement/products/ms2037c

http://www.anritsu.com/en-US/test-measurement/products/ms2038c

Contacting Anritsu for Sales and Service
To contact Anritsu, visit the following URL and select the services in your region:
http://www.anritsu.com/contact-us.

1-2 Instrument Description
The Anritsu VNA Master instruments are portable handheld vector network analyzers 
(VNAs) featuring precise performance and essential RF capabilities. These VNA Master 
instruments are designed to conduct accurate vector-corrected 1-port magnitude, phase, and 
fault location measurements and 2-port magnitude, phase, and group delay measurements 
from 5 kHz to 20 GHz. The MS203xC models add Spectrum Analyzer capabilities that 
provide quick and accurate measurement results for monitoring, measuring, and analyzing 
signal environments. The Spectrum Analyzer offers broad spectrum analysis with frequency 
coverage to 20 GHz, impressive dynamic range, and excellent phase noise performance. 
Standard measurements include field strength, occupied bandwidth (OBW), channel power, 
adjacent channel power ratio (ACPR), and carrier to interference (C/I) ratio.

Trace Storage
Time and date stamping of measurement data is automatic. The internal memory provides 
for the storage and recall of more than 4000 measurement setups and traces. External 
storage can be used for bulk measurement storage. Measurements and setups can be stored 
in a USB flash drive or transferred to a PC by using the included USB cable. Use 
Line Sweep Tools (LST) for certain VNA measurements and Master Software Tools (MST) for 
spectral analysis measurements. 

Note

Not all after-market USB drives are compatible with the VNA Master. Many drives 
come with a second partition that contains proprietary firmware. This partition must 
be removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. You may also try reformatting a drive that 
contains a single partition using FAT32 format.
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1-3 Available Models
Table 1-1 lists the VNA Master models described in this User Guide. 

Table 1-1. VNA Master Models

Model  Frequency Range

MS2026C Vector Network Analyzer: 5 kHz to 6 GHz
MS2027C Vector Network Analyzer: 5 kHz to 15 GHz
MS2028C Vector Network Analyzer: 5 kHz to 20 GHz
MS2036C Vector Network Analyzer: 5 kHz to 6 GHz

Spectrum Analyzer: 9 kHz to 9 GHz
MS2037C Vector Network Analyzer: 5 kHz to 15 GHz

Spectrum Analyzer: 9 kHz to 15 GHz
MS2038C Vector Network Analyzer: 5 kHz to 20 GHz

Spectrum Analyzer: 9 kHz to 20 GHz
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1-4 Identifying the Connections 
The VNA Master MS2026C, MS2027C, and MS2028C have the connectors shown in 
Figure 1-1.For details, refer to Figure 2-13 on page 2-20.

The VNA Master MS2036C, MS2037C, and MS2038C have the connectors shown in 
Figure 1-2.For details, refer to Figure 2-14 on page 2-21 

1-5 Soft Carrying Case and Tilt Bail
The soft carrying cases for the MS202xC and the MS203xC accommodate the different 
instrument sizes. The part numbers are in the Technical Data Sheet. The tilt bail is 
factory-installed on the VNA Master for use with or without the soft carrying case.

VNA Master Soft Carrying Case
The MS20xxC can be operated while in the soft carrying case. On the back of the case is a 
large storage pouch for accessories and supplies. 

To install the MS20xxC into the soft carrying case, perform the following:

1. The front panel of the case is secured with hook and loop fasteners. Fully open the front 
panel of the case.

Figure 1-1. MS202xC Connectors

Figure 1-2. MS203xC Connectors
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2. Place the soft carrying case face down on a stable surface, with the front panel fully 
open and laying flat.

3. Fully open the zippered back of the case.

4. Insert the MS20xxC face down into the case, taking care that the connectors are 
properly situated in the case top opening. Figure 1-3 shows the MS20xxC in the case.

Note

Two zippers are located around the back of the case. The zipper closer to the 
MS20xxC compartment of the case opens the case back and allows access to install 
and remove the MS20xxC. The other zipper closer to the back of the case opens a 
support panel that can be used to provide support for improved stability and air flow 
while in the case. This support panel also contains the storage pouch.

Figure 1-3. Instrument Inserted Into the Soft Carrying Case
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5. Close the back panel and secure it with the zipper .

The soft carrying case includes a detachable shoulder strap that can be connected to the 
D-rings on the upper corners of the case as required for comfort or convenience. The velcro 
strap acts as a tilt bail when using the soft case as shown in Figure 1-4.

Figure 1-4. VNA Master Installed in Soft Case
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VNA Master Tilt Bail Stand 
The supplied Tilt Bail can be used for desktop operation. The tilt bail provides a backward tilt 
for improved stability and air flow. Refer to Figure 1-5.

 To deploy the tilt bail, pull the bottom of the tilt bail away from the back of the unit.

To store the tilt bail, push the bottom of the bail toward the back of the unit and snap the 
bottom of the bail into the clip on the back of the unit.

Figure 1-5. Tilt Bail Extended on VNA Master
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1-6 Preventive Maintenance    
VNA Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connector on the instrument and all accessories. Clean the VNA Master with 
a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of N(f) and K(f) connectors and the pins 
of N(m) and K(m) connectors should be unbroken and uniform in appearance. If you are 
unsure whether the connectors are good, gauge the connectors to confirm that their 
dimensions are correct. Type K(f) test port connectors are available on some models with 
Option 11.

Visually inspect the test port cables. The test port cable should be uniform in appearance, not 
stretched, kinked, dented, or broken.

1-7 Calibration Requirements – Vector Network Analyzer     
The VNA Master is a field portable unit operating in the rigors of the test environment. In 
order to ensure measurement accuracy, RF calibration (OSLT or SSLT, for example) must be 
performed prior to making a measurement in the field.

The VNA Master has no field-adjustable components. The RF (OSLT, SSLT, and SSST) 
calibration components, however, are crucial to the integrity of the calibration and should be 
periodically verified to ensure their performance. This is especially important if the 
components have been dropped or over-torqued. 

1-8 Annual Verification   
Anritsu recommends an annual calibration and performance verification of the VNA Master 
and the calibration components by local Anritsu service centers. Anritsu service centers are 
listed our web site at anritsu.com/contact-us.

Caution To avoid damaging the display and case, do not use solvents or abrasive 
cleaners.

Note

For best calibration results (compensation for all measurement uncertainties), 
ensure that the calibration is performed at the end of the test port or optional 
extension cable; that is, at the same point that the device that is to be tested will be 
connected. 

Caution

For best results, use an Anritsu phase stable Test Port Extension Cable, such as 
those listed in the Technical Data Sheet for your instrument (refer to Appendix A). 
Use of a typical laboratory cable to extend the VNA Master test port to the device 
under test, or any bending of the cable subsequent to the OSL or OSLT calibration, 
may cause uncompensated phase reflections inside the cable. Reflections of this 
type cause measurement errors, which are more pronounced at higher frequencies.
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1-9 Battery Replacement   
The battery can be replaced without the use of tools. The battery compartment is located on 
the lower left side of the instrument. Slide the battery door down (towards the bottom of the 
instrument) to remove the door. Remove the battery pack from the instrument by pulling 
straight out on the battery lanyard. Replacement is the opposite of removal.  

The battery that is supplied with the VNA Master may need charging before use. The battery 
can be charged in the VNA Master by using either the AC-DC Adapter or the 12 Volt DC 
adapter, or can be charged separately in the optional Dual Battery Charger.  

Caution Use only Anritsu approved batteries, adapters and chargers with these 
instruments. 

1 Battery Compartment Door

Figure 1-6. MS20xxC VNA Master Battery Compartment Door

Caution

When using the Automotive 12 VDC Adapter, always verify that the supply is 
rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any 
dirt or debris. If the adapter plug becomes hot to the touch during operation, 
discontinue use immediately.

1
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1-10 ESD Caution     
The VNA Master, like other high performance instruments, is susceptible to ESD 
(electrostatic discharge) damage. Coaxial cables and antennas often build up a static charge, 
which may damage the VNA Master input circuitry (if allowed to discharge by connecting 
directly to the VNA Master without previously discharging the static charge). Operators 
must be aware of the potential for ESD damage and take all necessary precautions. 

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these apply to the VNA Master, Anritsu Company 
recommends that any static charges that may be present be dissipated before connecting 
coaxial cables or antennas to the VNA Master. This may be as simple as temporarily 
attaching a short or load device to the cable or antenna prior to attaching to the VNA Master. 
Remember that the operator may also carry a static charge that can cause damage. Following 
the practices outlined in the above standards helps to ensure a safe environment for both 
personnel and equipment.

1-11 RF Input Warning (MS203xC only)
The VNA Master is a sensitive measuring instrument designed to measure low power levels. 
Avoid damaging this sensitive circuitry by observing the maximum input levels printed on 
the instrument connector labeling and specified in the product technical data sheet.

On MS203xC instrument models, typical maximum input at the spectrum analyzer port is 
+30 dBm (±50 VDC) and could be less if additional features, such as a preamplifier, are in 
use. Be sure to review the product technical data sheet or Anritsu website for recommended 
components and accessories that can help you protect your instrument. These include a 
variety of adapters, attenuators, filters, and RF detection accessories.

Warning

VNA Masters are supplied with a rechargeable battery that could potentially leak 
hazardous compounds into the environment. These hazardous compounds 
present a risk of injury or loss due to exposure. Anritsu Company recommends 
removing the battery for long-term storage of the instrument and storing the 
battery in a leak-proof, plastic container. Follow the environmental storage 
requirements specified in the product data sheet.
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Chapter 2 — Quick Start Guide

2-1 Introduction
This chapter provides a brief overview of the Anritsu MS20xxC VNA Master handheld Vector 
Network Analyzer. The intent of this chapter is to provide you with a starting point for 
making basic measurements. For more detailed information, refer to the specific 
measurement mode chapters in this manual.

2-2 Turning the VNA Master On for the First Time
The Anritsu VNA Master is capable of greater than two hours of continuous operation from a 
fully charged, field-replaceable battery (refer to “Battery Replacement” on page 1-9 in 
Chapter 1, “General Information”). The VNA Master can also be operated from a 12 VDC 
source (which also simultaneously charges the battery). This can be achieved with either the 
Anritsu AC-DC Adapter or 12 VDC Automotive Adapter. Both items are included as standard 
accessories (refer to the Standard and Optional Accessories in the Technical Data Sheet for 
your instrument, as listed in Appendix A). 

Caution

When using the Automotive 12 VDC Adapter,, always verify that the supply is 
rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any dirt 
or debris. If the adapter plug becomes hot to the touch during operation, 
discontinue use immediately.
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To turn on the VNA Master, press the On/Off front panel button (Figure 2-1).  

The VNA Master requires approximately thirty-five seconds to complete the power-on cycle 
and load the application software. At the completion of this process, the instrument is ready 
to use.

The VNA Master performs a self test during each power-on cycle. If the self test fails, then 
refer to “Self Test or Application Self Test Error Messages” on page C-2 in 
Appendix C, “Error Messages”. For maximum accuracy, letting the instrument warm up for 
approximately 15 minutes is a good practice before performing a calibration.

1 On/Off Button

Figure 2-1. VNA Master On/Off Button (MS2028C shown) 

1
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2-3 Front Panel Overview
The VNA Master menu-driven flexible interface is intuitive and easy to use. Hard keys on the 
front panel are used to initiate function-specific menus. Five function hard keys (unlabeled) 
are located below the display. These keys vary in function depending upon the current mode 
of operation. If a function hard key has no function in the current mode, then the key label in 
the measurement display area is blank adjacent to that key. 

Located to the right of the display, the VNA Master has eight soft keys (unlabeled buttons), 
hard keys, arrow keys, and a rotary knob. The locations of all of the keys are shown in 
Figure 2-2. 

Nine of these hard keys (the number keys 1 through 9) are dual purpose, depending upon the 
current mode of operation. The dual-purpose keys are labeled with a number on the key itself 
and with the alternate function printed in blue (same color as the Shift key) on the panel 
above the key. Use the Shift key to access the functions printed on the panel above the 
number keys.

The eight soft keys (unlabeled buttons) are located adjacent to the right edge of the 
measurement display screen (or sweep window). These eight soft keys change function 
depending upon the current mode of operation and the menu selection. The current soft key 
function is indicated at the top of the active function block, which is located within the 
measurement display screen (or sweep window). The active function block displays a label for 
each active soft key. If a soft key has no function in the current mode, then the active function 
block display is blank adjacent to that soft key.

The Escape key (labeled Esc and used for aborting data entry) is the round button located 
above the eight (unlabeled) soft keys. 

The rotary knob and the keypad (and sometimes the arrow keys) can be used to change the 
value of an active parameter. The rotary knob can also be pressed to duplicate the action of 
the Enter key.

Note

Users who are familiar with the operation of previous VNA Master instruments will 
find that those menus are quite different from the menus for this current MS20xxC 
VNA Master. Some menus are the same, but those related to measurement 
setups and sweeps are very different. The intent with the MS20xxC is to provide 
you with more flexibility and choice in measurement configurations even if these 
choices result in configurations that are not very practical (such as the overlay of a 
Smith Chart on top of a rectilinear chart).
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Front Panel Overview Image  

1 Fan Exhaust Ports
2 Active Function Block or Soft Key Menu
3 Escape Key
4 Soft Keys (8 buttons)
5 Charge Fault LED
6 Battery Charge LED
7 On/Off Key
8 Directional Arrow Keys
9 Shift Key

10 Rotary Knob
11 Number Keypad
12 Enter Key
13 Fan Inlet Port
14 Function Hard Keys (5 buttons)
15 Measurement Display Screen (or Sweep Window)
16 Battery Compartment

Figure 2-2. Front Panel Overview
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Other Features on the Front Panel 

Battery Charge LED (Green)
The green Battery Charge LED (Figure 2-2, item 6) will flash if the battery is charging and 
will remain on and steady when the battery is fully charged. 

Charge Fault LED (Red)
The red Charge Fault LED (Figure 2-2, item 5) will remain on and steady under a battery 
charger fault condition. Fault conditions include a battery cell voltage that is too low to 
charge, or a battery temperature outside the acceptable temperature range to charge. 

Fan Inlet and Exhaust Ports
The fan inlet (Figure 2-2, item 13) and exhaust ports (Figure 2-2, item 1) must be kept clear 
of obstructions at all times for proper ventilation and cooling of the instrument.
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2-4 Typical Vector Network Analyzer Display    
Figure 2-3 illustrates some of the key information areas of the vector network analyzer 
display screen on the VNA Master MS20xxC. The measurement and the display type that are 
illustrated here may not be the same as currently shown on your instrument. The purpose of 
the figure is to show the general areas of the display, which are labeled in the figure. Refer to 
the VNA Measurement Guide, Chapter 6, “VNA Menus” for more detailed soft key 
descriptions (refer to Appendix A for document part numbers).  

1 Instrument Settings Summary (unique to each trace)
2 Real Time Clock
3 Measurement Display Area (or Sweep Window)
4 Instrument Settings Summary (applies to all traces)
5 Battery Charge Indicator
6 Soft Key Labels (or Active Function Block)
7 Function Hard Key Labels

Figure 2-3. Vector Network Analyzer Smith Chart Display
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The MS20xxC features a versatile new display option for better measurement convenience. 
Because the VNA Master measures all four S-parameters simultaneously, with 
fully-reversing test signals at both Port 1 and Port 2, the measurement display provides up to 
4 simultaneous window images. As shown in Figure 2-4, each one of the S-parameters could 
be displayed in its own quarter window. Additionally, the display could be divided into three, 
two, or one graph areas. An example of four S-parameters overlaid onto one graph area is 
shown in Figure 2-5.  

Figure 2-4. 4 Traces in 4 Window Images (Quad Trace Format)
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Figure 2-5. 4 Traces in 1 Window Image (Single Trace Format)
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Instrument Settings Summary  
The instrument settings that apply to all traces are summarized in the top two rows of the 
measurement display screen (refer to item 2 in Figure 2-6). The summary includes the 
Number of Points, the IF Bandwidth, the Averaging count, the Port Power level, and the 
Bias Tee status, all of which apply to both ports. The summary also includes the Reference 
Plane Extension values, which differ for each port. 

1 Instrument Settings Summary (unique to each trace)
2 Instrument Settings Summary (applies to all traces)

Figure 2-6. Instrument Settings Summary on Measurement Display Screen

1 2
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The instrument settings that are unique to each trace are summarized in an 
information block on the left side of the measurement display screen (refer to item 1 in 
Figure 2-6). Each block contains the trace number followed by the S-parameter that is 
assigned to that trace (TR4: S22, for example). If the trace has Trace Math applied to 
it, then the math function is also displayed on that line (TR1: S11/M1, for example), 
where M1 is the memory that is associated with TR1, and the math function is 
Trace/Memory). The S-parameter that is assigned to the trace memory is shown (if 
enabled) at the top of each trace information block (M1: S11, for example). Each trace 
block also includes the Graph type, the smoothing percentage, the calibration status, 
and the scale (Resolution per Division and the Reference Value). The calibration status 
indicates whether the calibration is ON, OFF, or non-existent (--) for the specific 
S-parameter that is assigned to each trace. If the Calibration is ON, then its validity is 
also displayed (OK,?, or X).
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2-5 Typical Spectrum Analyzer Display  
Figure 2-7 illustrates some of the key information areas of the spectrum analyzer display 
screen on the VNA Master MS20xxC. The measurement and the display type that are 
illustrated here may not be the same as currently shown on your instrument. The purpose of 
the figure is to show the general areas of the display, which are labeled in the figure. Refer to 
the Spectrum Analyzer Measurement Guide for more detailed soft key descriptions. 
Measurement Guide part numbers are listed in Table A-1, “Measurement Guides” 
on page A-1 

1 Instrument Settings Summary (unique to each trace)
2 Real Time Clock
3 Measurement Display Area (or Sweep Window)
4 Instrument Settings Summary (applies to all traces)
5 Battery Charge Indicator
6 Soft Key Labels (or Active Function Block)
7 Function Hard Key Labels (specific to instrument Mode settings)

Figure 2-7. Typical Spectrum Analyzer Display Screen
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2-6 Front Panel Keys  
The term hard key refers to all of the buttons on the instrument face except for the vertical 
row of gray buttons adjacent to the measurement display. These eight gray buttons are called 
soft keys, and they are used to activate virtual soft key buttons within the measurement 
display screen. This soft key display area (soft key menu) is also called the active function 
block. Refer to Figure 2-2 (item 2) and Figure 2-3 (item 6) and Figure 2-7 (item 6).

Esc Key 
Pressing this key cancels any setting that is currently being made. Refer to Figure 2-2 
(item 3). The Esc key is located directly above the eight soft keys.

Enter Key 
Press this key to finalize data input. Pressing the rotary knob performs this same function. 
Refer to Figure 2-2 (item 12). The Enter key is located directly below the Number 3 key in the 
number keypad.

Arrow Keys 
The four arrow keys (between the rotary knob and the Esc key) are used to scroll up, down, 
left, or right. Refer to Figure 2-2 (item 8). The arrow keys can often be used to change a value 
or to change a selection from a list. This function is similar to the function of the rotary knob. 
The arrow keys are also used to move markers.

Shift Key  
Pressing the Shift key (refer to Figure 2-2, item 9 and Figure 2-8) and then a number key 
executes the function that is indicated in blue text above the number key. When the Shift key 
is pressed (when it is active), its icon is displayed in the upper right corner of the 
measurement display area between the battery charge indicator and the soft key menu label. 

Back Key 
Press this key to delete only one character, one number, or the range that is specified by the 
cursor. The Back key is located directly above the Number 7 key in the number keypad.

Plus/Minus (+/–) Key 
Press this key to change the sign of numbers that are entered with the number keys. The 
Plus/Minus (+/-) key is located directly above the Number 8 key in the number keypad.

Figure 2-8. Shift Key Icon
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Number Keypad 
These keys are used to directly input numeric values.

Rotary Knob 
Turning the rotary knob (refer to Figure 2-2, item 10) changes numerical values, scrolls 
through selectable items from a list, and moves markers. Values or items may be within a 
dialog box or an edit window. Markers are moved within the sweep window.

Pressing this knob finalizes the input function in the same manner as pressing the Enter key.

Function Hard Keys  
These five function keys (refer to Figure 2-2, item 14) are horizontally arranged adjacent to 
the measurement display screen along the lower edge. These buttons have no labels. As with 
the soft keys, they are positioned to accompany virtual key labels that are displayed to match 
instrument modes and functions. These function hard key labels change to match specific 
instrument Mode settings. Each Mode uses a specific set of Function Hard Keys. For details 
about selecting the Mode, refer to the Section “Mode Selector” on page 2-19. In some manuals, 
such as Measurement Guides, the Function Hard Keys are referred to as Main Menu Keys.

Soft Keys  
These eight gray keys have no labels (refer to Figure 2-2, item 4). They are arranged adjacent 
to the measurement display screen along the right-hand edge. They are positioned to 
accompany virtual soft key labels that are displayed to match instrument modes and 
measurement functions. These soft key labels (also called the Active Function Block) change 
as instrument measurement settings change. In some manuals, such as Measurement 
Guides, the Soft Keys are referred to as Submenu Keys.

The following Section 2-7 “Soft Key Types” describes how these keys are used:

2-7 Soft Key Types  

Select
A Select soft key has a small circle in the upper right corner of the virtual key face and is 
used to select the function or item that is displayed on the virtual soft key label. When not 
selected, the circle is gray. When selected, the circle is red to indicate that the function is 
active.

Press the key to make the selection. Press a different key to make a different selection.

A Select soft key may also be a Switching soft key. Switching soft keys show both a gray 
circle and an arrow mark (-->). 

A Select soft key may change to a Switching soft key when active. These keys show only the 
gray circle when not active, but show the arrow mark as well as the red circle when active. 
Refer to section “Switching” on page 2-14.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



2-7 Soft Key Types Quick Start Guide

2-14 PN: 10580-00305  Rev. N MS20xxC UG

Input
An Input soft key is used to select an item or a value. This type of soft key displays the setting 
parameter and the setting value on the virtual key face. When the key is pressed, a select box 
or edit box may open on the display screen, or the key face may turn a darker gray color to 
show that the setting is being made. At any time before finalizing the input, press the escape 
(Esc) key to abort the change and retain the previously existing setting.

To set or select an item or a value, use the number keys, the arrow keys, or the rotary knob. 
Press the rotary knob or the Enter key to finalize data input. If a value is being selected or 
entered, then the soft key Active Function Block may change to provide one or more soft keys 
for units, such a Hz or dB. Pressing a unit soft key sometimes finalizes the data input in the 
same manner as pressing the Enter key. If more than one unit key is displayed, then pressing 
the Enter key without first pressing a unit key selects a specific unit by default. The specific 
default units are described along with soft key descriptions that are included in the analyzer 
chapters and the Measurement Guides.

With some functions, only a specific set of values are valid. When scrolling with the Up/Down 
arrow keys or the rotary knob, only valid values are offered. If different values are set with 
the number keypad, then those values might not be accepted. Even if different values are 
accepted on the soft key face, the values may not be valid for the selected measurement. Your 
knowledge of measurement functions must be used to determine acceptable values.

Toggle
A Toggle soft key displays the setup item and the toggle states. Toggle states may be On and 
Off or may be a selection of types or values such as Reference Impedance: 50 ohm or 75 ohm.

Each press of the Toggle soft key moves the selection to the next value or item in sequence. 
The selected item or value is underlined on the virtual key face.

Switching
A Switching soft key is used to open an additional soft key menu, and it has an arrow 
mark (-->) in the lower right corner of the virtual key face. 

Some Select soft keys become Switching soft keys after being pressed (after becoming active). 
These keys may not display the arrow mark until they are active (their circle is red). An 
additional press, after the circle is red and the arrow mark is displayed, opens the additional 
soft key menu. Refer to section “Select” on page 2-13.

The Switching soft key that is labeled More opens a menu with additional soft key functions. 
The Switching soft key that is labeled Back returns to a previous soft key menu. The Back key 
has the arrow mark (<--) in the lower left corner of the virtual key face.
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2-8 Parameter Setting
Pop-up list boxes, edit boxes, and dialog boxes are used to provide selection lists and selection 
editors. Scroll through a list of items or parameters with the arrow keys or the rotary knob. 
Select numerical values by scrolling with the arrow keys or rotary knob or by entering the 
digits directly from the number keypad. These list boxes and edit boxes frequently display a 
range of possible values or limits for possible values.

Finalize the input by pressing the rotary knob or the Enter key. At any time before finalizing 
the input, press the escape (Esc) key to abort the change and retain the previously existing 
setting.

Cable parameters can be added to list boxes by creating them in Line Sweep Tools (LST). 
Signal Standard parameters can be added to list boxes by creating them in Master Software 
Tools (MST). Refer to Chapter 8, “Anritsu Tool Box” for a brief overview of these software 
tools.

2-9 Text Entry 
When entering text (as when saving a measurement) the soft key menu for Text Entry displays 
the characters (alphabet, hyphen, and underscore) in groups of 6 letters per soft key. 
Characters can be entered by using the rotary knob, the arrow keys, or the soft keys.

The rotary knob scrolls through the characters in a pop-up window and is pressed to select 
each character in sequence. 

Alternatively, press the a b c / d e f soft key (for example) to open another soft key menu with 
a separate key for each of these letters. The menu returns to the complete character set after 
each individual letter is entered. 

Use the arrow keys to navigate within a name or character string. Use the Shift key for 
capital letters. Press the Enter key or the rotary knob to finalize a text entry.
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Refer to Figure 2-9, Figure 2-10, and Figure 2-11. 

Figure 2-9. Text Entry Menu – Lower Case
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Figure 2-10. Text Entry Menu – Upper Case
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Figure 2-11. Text Entry Menu – Selecting Characters

Rotary Knob has scrolled 
to letter “h”
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2-10 Mode Selector    
Select a VNA Master measurement mode (such as Vector Network Analyzer or Vector Volt 
Meter) by opening the Mode Selector List Box. Press the Shift key, then the Mode (9) key, and 
choose a mode from the menu. Use the directional arrow keys or the rotary knob to highlight 
your selection, and then press the Enter key.

The modes that are available on your VNA Master depend upon the options that are installed 
and activated. Your instrument may not show the same list as Figure 2-12. 

Figure 2-12. Mode Selector List Box
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2-11 Test Panel Connectors
The connectors and indicators that are located on the test panel of the VNA Master are shown 
and described in the following sections.

MS202xC Test Panel Connectors    
The connectors and indicators that are located on the test panel of the MS2026C, MS2027C, 
and MS2028C are shown in Figure 2-13 and are described in the table below the figure. 

1 Fan Exhaust Port
2 GPS Antenna Input for Option 31
3 External Reference Input
4 External Trigger Input
5 RF Detector Interface (for Option 5)
6 Test Port 1 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
7 Bias Input Port 1
8 Bias Input Port 2
9 Test Port 2 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
10 Port 2 LED
11 External Power Input
12 LAN Connection
13 USB Interface, Type A (2 connectors, Full Speed USB 2.0)
14 USB Interface, Type Mini-B (Full Speed USB 2.0)
15 Headset Jack
16 Bias Status LED
17 Port 1 LED

Figure 2-13. MS202xC Test Panel Connectors
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MS203xC Test Panel Connectors  
The connectors and indicators that are located on the test panel of the MS2036C, MS2037C, 
and MS2038C are shown in Figure 2-14 and are described in the table below the figure. 

1 External Reference Input
2 Fan Exhaust Port
3 Reference Out (10 MHz)
4 Spectrum Analyzer RF Input (50 ohm)
5 Test Port 1 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
6 Bias Input Port 1
7 Bias Input Port 2
8 Test Port 2 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
9 Port 2 LED

10 External Power Input
11 LAN Connection
12 USB Interface, Type A (2 connectors, Full Speed USB 2.0)
13 USB Interface, Type Mini-B (Full Speed USB 2.0)
14 Headset Jack
15 Bias Status LED
16 Port 1 LED
17 GPS Antenna Input for Option 31
18 External Trigger Input

Figure 2-14. MS203xC Test Panel Connectors
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In Figure 2-15, a waveguide-coax adapter at Test Port 1 provides test connections, and typical 
waveguide calibration components are shown below the VNA Master. 

LAN Connection    
The RJ45 connector is used to connect the VNA Master to a local area network. Refer to 
Figure 2-13, item “12” on page 2-20. Integrated into this connector are two LEDs. The amber 
LED indicates the speed of the LAN connection (ON for 10 Mb/s and OFF for 100 Mb/s), and 
the green LED flashes to show that LAN traffic is present. The instrument Ethernet address 
can be set automatically using DHCP, or manually by entering the desired IP address, 
gateway address, and subnet mask. These settings are described in more detail in 
Appendix G, “More About DHCP”.

Figure 2-15. Waveguide-Coax Adaptor and Waveguide Calibration Components

Note

An active Ethernet cable must be connected to the MS20xxC before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address. 
Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable. 

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the MS20xxC before cycling the power OFF and back ON.
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Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP and is the most common method of 
configuring a device for network use. To determine if a network is set up for DHCP, connect 
the VNA Master to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the VNA Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power-on sequence.

To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options soft key and the Ethernet Config soft key. The IP address is 
displayed as shown in Figure 2-16. For more information about DHCP, refer to 
Appendix G, “More About DHCP”.

Note In order to acquire an address from a DHCP protocol network, the VNA Master 
MUST be connected to the network BEFORE being switched on.

Figure 2-16.  IP Address Assigned Using DHCP
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USB Interface - USB Type Mini-B   
The USB 2.0 interface can be used to connect the VNA Master directly to a PC. Refer to 
Figure 2-13, item “14” on page 2-20 for the USB connector location. The first time the 
VNA Master is connected to a PC, the normal USB device detection will be performed by the 
computer operating system. 

 

USB Interface - USB Type A   
The VNA Master can also act as a USB Host, which allows various USB Flash Memory 
devices to be connected to the instrument for storing measurements and setups. Refer to 
Figure 2-13, item “13” on page 2-20.   

Note For proper detection, either Line Sweep Tools or Web Remote Tools must be 
installed on the PC prior to connecting the VNA Master to the PC USB port. 

Figure 2-17. MS2028C Connected to PC via USB Mini-B

Note

For proper operation with the instrument, USB Flash Drives should be formatted 
using either FAT (for drives that are 2GB or less) or FAT32. 

USB drives with NTFS formatting may not be correctly recognized by the 
instruments.
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2-12 VNA Master Connectors

External Power    
This is a 2.1 mm by 5.5 mm barrel connector, 12 VDC to 15 VDC, < 5.0 A. The external power 
connector is used to power the unit and for battery charging. Refer to Figure 2-13, item “11” 
on page 2-20. Input is 12 VDC to 15 VDC at up to 5.0 A. A green flashing indicator light near 
the power switch shows that the instrument battery is being charged by the external 
charging unit. The indicator is steadily illuminated when the battery is fully charged.  

Ext Trigger (50 ohm)   
Refer to Figure 2-13, item “4” on page 2-20. BNC female connector, TTL 3.3 V to 5 V, triggers 
on positive edge. Maximum input is +5 VDC. This connector is not active in all instrument 
modes.

Ext Freq Ref (50 ohm)  
The BNC female connector (refer to Figure 2-13, item “3” on page 2-20) is used for connection 
of an external frequency reference. Press the External Reference soft key under the System 
menu and then the Application Options menu to set the reference to external (10 MHz). The 
amplitude of the External Reference should be between –10 dBm and +10 dBm.

RF Detector (DIN)   
The RF detector connector (refer to Figure 2-13, item “5” on page 2-20) is used for Power 
Monitor measurements (Option 5). Refer to the table of available RF Detectors in the 
Technical Data Sheet for your instrument (refer to Appendix A). Note that this option was 
available only on the MS202xC models, and that the option has been discontinued. Option 19, 
High Accuracy Power Meter, is equivalent with superior functionality.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the RF 
detector connector. This 4-pin DIN connector has a bayonet shell that locks in a manner 
similar to a BNC connector. Do not over tighten this connector.

Warning

When using the AC-DC Adapter, always use a three-wire power cable connected 
to a three-wire power line outlet. If power is supplied without grounding the 
equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

Note

If the battery is completely depleted, then the VNA Master may not turn on even 
when the external power supply is plugged into the unit. In that case, allow the 
battery to charge while the instrument is turned off before attempting to turn on the 
instrument.
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Port 1 (50 ohm)    
This Type-N connector (see Figure 2-13, item “6” on page 2-20) provides the input/output 
50 ohm interface for transmission and reflection measurements of the Vector Network 
Analyzer at Port 1. Maximum input is +23 dBm at ±50 VDC. Bias Tee output is also 
available from this port (with Option 10). The Port 1 green LED (see Figure 2-13, item “17” on 
page 2-20) indicates, when lit, that the port is transmitting power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overly tighten the connector. The recommended torque is 12 lbf·in 
to 15 lbf·in (1.36 N·m to 1.70 N·m).

Port 2 (50 ohm)   
This Type-N connector (see Figure 2-13, item “9” on page 2-20) provides the input/output 
50 ohm interface for transmission and reflection measurements of the Vector Network 
Analyzer at Port 2. Maximum input is +23 dBm at ±50 VDC. Bias Tee output is also 
available from this port (with Option 10). The Port 2 green LED (see Figure 2-13, item “10” on 
page 2-20) indicates, when lit, that the port is transmitting power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overly tighten the connector. The recommended torque is 12 lbf·in 
to 15 lbf·in (1.36 N·m to 1.70 N·m).

Type K Connectors (Option 11) for VNA Ports   
To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-K connector. Do not over tighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Bias Input Port 1  
The BNC female connector (see Figure 2-13, item “7” on page 2-20) is used for external bias 
tee input that will be routed to Port 1 of the VNA Master. Maximum input is ±50 VDC, 
500 mA.

Bias Input Port 2 
The BNC female connector (see Figure 2-13, item “8” on page 2-20) is used for external bias 
tee input that will be routed to Port 2 of the VNA Master. Maximum input is ±50 VDC, 
500 mA.

Bias Status LED  
This LED (see Figure 2-13, item “16” on page 2-20) illuminates green when Internal or 
External Bias is selected. When using the internal supply, it illuminates red for any overload 
condition (current or voltage).

Headset Jack  
Instrument models that include a spectrum analyzer will output demodulated audio to this 
3.5 mm 2-wire jack, which also accepts most 3-wire headsets. (See Figure 2-13, item “15”.)
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2-13 Connector Care 
Visually inspect connectors for general wear, for cleanliness, and for damage such as bent 
pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors 
can limit the accuracy of your measurements. Damaged connectors can damage the 
instrument. Connection of cables carrying an electrostatic potential, excess power, or excess 
voltage can damage the connector or the instrument or both. Connection of cables with 
inadequate torque settings can affect measurement accuracy. Over torquing connectors can 
damage the cable, the connector, the instrument, or all of these items.

Torque values are written as (for example) 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m), 
where “lbf·in” means pounds (force) inches or “inch pounds of force”, and “N·m” means 
“Newton meters of force”.

Connecting Procedure (for Type-N and Type-K)      
1. Carefully align the connectors.

The male connector center pin must slip concentrically into the contact fingers of the 
female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight 
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, then initially tighten by hand so that approximately 
1/8 turn or 45 degrees of rotation remains for the final tightening with the torque 
wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over torque the connector.

Disconnecting Procedure  
1. If a wrench is needed, then use an open-end wrench to keep the connector body from 

turning while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.
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GPS Antenna Connector    
This GPS antenna connection is for GPS only (Option 31 only). Refer to Figure 2-13, item “2” 
on page 2-20. 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not over tighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Reference Output, 10 MHz (50 ohm)
This port is present only on MS203xC instrument models. The SMA female connector (see 
Figure 2-14, item “3” on page 2-21 ) provides an output to the internally generated 10 MHz 
reference signal.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not over tighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Spectrum Analyzer RF In (50 ohm)  
This port is present only on MS203xC instrument models (see Figure 2-14, item “4” on 
page 2-21). It provides the input 50 ohm interface for the Spectrum Analyzer function. 
Maximum input is +30 dBm at ±50 VDC.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not over tighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

Type K Connectors (Option 11) for RF In Port  
The K connector option configures the VNA Master with K connectors at the Spectrum 
Analyzer RF In port and at the VNA Ports.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
K connector. Do not over tighten the connector. The recommended torque is 8 lbf·in (0.9 N·m 
or 90 N·cm).

Note

The GPS antenna connection on the VNA Master is fitted with an SMA connector. 
A DC voltage (3.3 V or 5.0 V) is present on this connector to support active GPS 
antennas. Connect only supported antennas, such as the Anritsu GPS antenna 
(part number 2000-1528-R) to this port.
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2-14 Symbols and Indicators 
The following symbols, icons, and indicators convey the instrument status or condition on the 
display. The colors shown here are in the standard or default display mode. 

Symbols and Icons on the Title Bar 
The instrument title bar displays the system date and time. When GPS is on and is tracking 
satellites, its icon is followed by latitude and longitude coordinates.

The battery symbol indicates the charge remaining in the battery. The colored section inside 
the symbol changes size and color with the charge level. When external power is applied, and 
no battery is installed, the red plug body is displayed as a substitute for the battery symbol.

Table 2-1. Symbols and Icons

Symbol Description

Green: Battery is 30 % to 100 % charged   

Yellow: Battery is 10 % to 30 % charged

Red: Battery 0 % to 10 % charged

Green with Black Plug body: Battery is fully charged, and 
external power is applied.

Lightning Bolt: Battery is being charged (any color symbol).

Red Plug body: External power is applied, and no battery is 
installed, or battery has lost communications with the instrument. 

Shift Key Icon: This icon is displayed between the battery symbol 
and the Soft Key Menu after the Shift key has been pressed, and 
until another key is pressed.

GPS Icon: When GPS is available, this icon is displayed right after 
the date and time. Refer to the GPS chapter for details.

Shift
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The Battery Charge LED (adjacent to the On/Off button) flashes when the battery is 
charging, and remains on steady when the battery is fully charged. 

The Shift key icon is displayed after the Shift key is pressed, and it remains displayed until 
another button is pressed.

Hold 
A HOLD MODE message is displayed when the VNA Master is on hold. To resume sweeping, 
toggle from Hold to Run in the Sweep menu.

Single Sweep 
The Single Sweep message is displayed when Single Sweep is selected. Single, Continuous, or 
External Trigger can be selected in the Sweep Menu.

External Trigger 
The External Trigger message is displayed when Ext is selected. Single, Continuous, or 
External Trigger can be selected in the Sweep Menu.

2-15 Memory Profile and Security Issues  
This section describes the profiles of the various types of memory that are used in the 
MS20xxC VNA Master and the associated security issues that are related to those memory 
devices.

The MS20xxC has 1 GB of Flash non-volatile memory, has EEPROM memory, and has 
sufficient DRAM volatile memory for normal operation. The instrument is supplied with a 
USB memory device that plugs into the USB Type A connector. The MS20xxC does not have a 
hard drive or any other type of volatile or non-volatile memory.

The following sections describe how memory is used in the VNA Master and how it can be 
erased.

Internal Flash Memory   
This memory space is used to store the instrument firmware and factory calibration, and can 
be used to store measurements and setups that are saved by the user.

Saved measurements and setups stored in the Flash memory are all deleted by the master 
reset process that is described in “MS20xxC Master Reset Instructions” on page 2-31. 

Caution 
Use only Anritsu-approved batteries, adapters, and chargers with this instrument. 
Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Note With Option 7 enabled, the user is not able to store any measurements or setups to 
this internal flash memory.
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USB Memory Device     
A USB memory device is not required for operating the instrument. You can store 
measurement and setup data directly on a USB memory device, or you may transfer the 
contents of internal memory to the USB device. 

RAM Memory    
This is volatile memory that is used to store many parameters needed for the normal 
operation of the MS20xxC along with current measurements. This memory is reset whenever 
the instrument is restarted.

EEPROM  
This memory holds information such as the model number, serial number, and calibration 
data for the instrument. Also stored here are the operating parameters, such as frequency 
range, that are set by the user. During the master reset process, all operating parameters 
that are stored in the EEPROM are set to standard factory default values.

MS20xxC Master Reset Instructions  
1. Turn on the instrument.

2. Press the Shift key, then the System (8) key.

3. Press the System Options key.

4. Press the Reset key.

5. Press the Master Reset key.

6. A dialog box is displayed on the instrument screen to warn that all settings will be 
returned to factory default values, and that all user files will be deleted.

7. Press the Enter key to execute the master reset, or press the Esc key to abort.

8. After several seconds (which can grow to several minutes if a very large number of 
measurements have been saved in the instrument), the instrument reboots.  

Note With Option 7 enabled, the user does not have access to the instrument’s internal 
memory and can only save to or load from a USB device.

Caution 

Use of Master Reset (System+On), will permanently erase all user saved setups 
and measurement traces and will return the VNA Master to a full Factory Default 
condition. Be sure to make backup copies of any important files before proceeding 
with a Master Reset.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



2-16 System Settings Quick Start Guide

2-32 PN: 10580-00305  Rev. N MS20xxC UG

2-16 System Settings   
To access the System menu, press the Shift key, then the System (8) key. Refer to 
Chapter 6, “System Operations ”.

Power On Self Test
At power on, the VNA Master runs through a series of quick checks to ensure that the system 
hardware is functioning properly. Refer to “Power On Self Test” on page 6-14 and to “Self 
Test” on page 6-4.

Vector Network Analyzer Mode  
The “Application Options Menu (VNA Mode)” on page 6-5 contains the selections for Units, 
External Reference, Trace Label, Measurement Gain Range, and Time Domain (if applicable). 

Time Domain  
When the Time Domain Option (Option 2) is enabled, certain aspects of the measurements 
are determined by the settings in this menu. Refer to the Vector Network Analyzer 
Measurement Guide (listed in Appendix A) for a detailed description of this menu.

Spectrum Analyzer Mode 
The “Application Options Menu (SPA Mode)” on page 6-7 contains the Impedance setting 
selection and an Auto Ref Level selection. 

Frequency Blanking  
This feature is available with Option 7 installed. Refer to “Frequency Blanking” on page 4-5.

Power–On and Power Switch Feature  
This feature allows you to turn instrument power off and on from a remote location. Refer to 
“System Options Menu” on page 6-8, “System Options 2/2 Menu” on page 6-12, and 
“Power–On Menu” on page 6-13.

Remote Access Password  
This security feature is described in “System Options 2/2 Menu” on page 6-12.
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Chapter 3 — Power Monitor, Option 5 

3-1 Introduction    
When equipped with Option 5, Power Monitor, the MS202xC VNA Master can be used for 
making power measurements with broadband RF detectors, such as those listed in the 
Technical Data Sheet for your instrument, as listed in Appendix A. The power monitor 
displays the measured power results in dBm or Watts. 

The function hard keys that are displayed in this mode are:

Freq, Scale, Save/Recall, Measure, Marker 
Only the Save/Recall and Measure function hard keys are functional in this mode. The other 
three function hard keys provide no valid functions.

3-2 Using the Power Monitor 
1. On the VNA Master, press the Shift key, then the Mode (9) key.

2. Use the directional arrow keys or the rotary knob to highlight Power Monitor and then 
press the Enter key.

3. Connect the power sensor to the VNA Master RF Detector port.

Zeroing the Power Monitor  
1. With no power applied to the Power Detector input, press the Zero soft key. Wait for a 

few seconds while the VNA Master accumulates data samples of the quiescent power. 

2. When complete, Zero: On is displayed in the message area.

Measuring High Input Power Levels   
1. Insert an attenuator between the DUT and the RF Detector to protect the VNA Master 

so that the power level is less than or equal to +16 dBm.

2. Press the Offset soft key and enter the attenuation by using the keypad, the arrow keys, 
or the rotary knob. 

3. Press the Enter key to complete the entry.

Note
This option has been discontinued. 

Option 19, High Accuracy Power Meter, offers equivalent and superior 
functionality. The Power Meter measurement guide is listed in Appendix A.

Note Option 5 is not available in the MS203xC VNA Master models.
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Displaying Power in dBm or in Watts
Press the Units soft key to toggle between dBm and Watts.

Setting Relative Power   
1. With the desired base power level input to the VNA Master, press the Relative soft key. 

The power reading shows 100% because it is measuring the same power level. 

2. If the power is lowered by 3 dB, then the relative power will show 50%. 

3. If the power in Watts is increased from 1 Watt to 2 Watts, then the relative power will 
show 200%.

In Figure 3-2, the Units are set for dBm, the Relative Power function is Off, the Offset 
is 1 dBm, and the Zero function is set to Off. The figure is intended to illustrate the general 
layout of the Power Monitor display. The displayed image on your instrument may be 
different.

1 DUT (Device Under Test)
2 RF Out
3 Attenuator
4 RF Detector (Power Sensor)
5 RF Detector Interface (for Option 5)
6 VNA Master

Figure 3-1. Power Measurement Setup With Attenuator

3 3

1 2 3 4

5

6
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3-3 Power Monitor Display  

3-4 Power Monitor Menu  

Figure 3-2. Power Monitor Display

Units 
dBm Watts: Press this key to toggle units between dBm and Watts.
Relative Power 
On Off: Press this key to turn relative power On or Off.

Offset: Press this key to enter an offset value to account for any external 
attenuator that is used during a measurement.
Zero  
On Off: Press this key to toggle zeroing On in order to perform Zeroing of 
the power monitor detector.

Figure 3-3. Power Monitor Menu

Offset

Units
dBm             Watts

Relative Power
On                Off

Zero
On                Off

Power Monitor
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Chapter 4 — Secure Data, Option 7

4-1 Introduction  
When equipped with Option 7, the MS20xxC VNA Master provides for careful management of 
confidential data for both the setup parameters and the resulting measured data. 

Highly sophisticated systems and equipment have technical applications that must remain 
secure in their operations. The particular parameters that must remain secure usually 
involve operating frequencies and a variety of other setup configurations.

To accommodate the measurements and yet preserve the data as confidential, Option 7 can be 
used to prevent any setup data or measured data from being stored on any internal memory 
location of the VNA Master. Instead, all such data are forced to be stored on removable 
memory such as an external USB memory device. 

4-2 Procedure
When saving data (setups, measurements, JPEG, and so forth) in a VNA Master with 
Option 7, the save location must be an external USB memory device. If a USB memory device 
is not connected to the instrument, then you cannot perform the save function.

You can use the following steps to change the save location while saving a file:

1. Press the Shift key, then the File (7) key.

2. Press the Save soft key.

3. Press the Change Save Location soft key.

4. Use the rotary knob or arrow keys to highlight the external USB memory device or any 
desired folder on that device.

5. Press the Create Folder soft key to create a new folder, if desired.

6. Press the Set Location soft key to set the highlighted folder or drive as the target 
location.

7. Press the Change File Type soft key to pick a different file type, if desired.

8. Use the Text Entry soft keys to enter the desired file name.

9. Press Enter to save the file.

Caution  

Note that even with Option 7 enabled, operating parameters (such as frequency 
range, power level, number of points) that are set by the user are stored in the 
VNA Master EEPROM when the VNA Master is turned OFF. These parameters 
can be erased, however, via a Master Reset operation, as described later in this 
chapter.
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4-3 Calibration Setup    
After any user calibration, the VNA Master automatically writes the calibration file to 
internal memory. This is done so that when the instrument is turned Off and then back On, 
the user calibration data are recalled, and the calibration can be applied. 

With Option 7 enabled, however, the VNA Master cannot write to internal memory. 
Therefore, the user calibration file is not automatically saved. With Option 7 enabled, when 
the instrument is turned Off and then back On, the user calibration data are not recalled, and 
the calibration cannot be applied. To save and recall the calibration, use the file save menu to 
save the setup with calibration to USB memory. Then use the file recall menu to retrieve the 
calibration.
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4-4 Memory Profile and Security Issues   
This section describes the profiles of the various types of memory that are used in the 
MS20xxC VNA Master and the associated security issues that are related to those memory 
devices.

The MS20xxC has 1 GB of Flash non-volatile memory, has EEPROM memory, and has 
sufficient DRAM volatile memory for normal operation. The instrument is supplied with a 
USB memory device that plugs into the USB Type A connector. The MS20xxC does not have a 
hard drive or any other type of volatile or non-volatile memory.

The following sections describe how memory is used in the VNA Master and how it can be 
erased.

Internal Flash Memory   
This memory space is used to store the instrument firmware and factory calibration, and can 
be used to store measurements and setups that are saved by the user. 

Saved measurements and setups that are stored in the Flash memory are all deleted by the 
master reset process that is described in Section “MS20xxC Master Reset Instructions” on the 
following page. 

USB Memory Device     
The USB memory device is not required for proper operation of the instrument. The 
instrument may be directed to store measurements and setups directly to the USB memory 
device, or you may transfer the contents of the internal flash memory into the USB memory 
device for storage or data transfer purposes. The device is removable and therefore does not 
pose a security risk because it can remain in a secured area, can be externally erased by a 
computer, or can be destroyed. 

RAM Memory    
This is volatile memory that is used to store many parameters that are needed for the normal 
operation of the MS20xxC along with current measurements. This memory is reset whenever 
the instrument is restarted.

EEPROM  
This memory holds information such as the model number, serial number, and calibration 
data for the instrument. Also stored here are the operating parameters, such as frequency 
range, that are set by the user. During the master reset process, all operating parameters 
that are stored in the EEPROM are set to standard factory default values.

Note With Option 7 enabled, the user is not able to store any measurements or setups to 
this internal flash memory.

Note
With Option 7 enabled, the user does not have access to the internal flash memory 
and, therefore, cannot transfer any contents of the internal flash memory into the 
USB memory device.
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MS20xxC Master Reset Instructions  
1. Turn the MS202xC or MS203xC On.

2. Press the Shift key then the System (8) key.

3. Press the System Options soft key.

4. Press the Reset soft key.

5. Press the Master Reset soft key.

6. A dialog box is displayed on the instrument screen to warn that all settings will be 
returned to factory default values, and that all user files will be deleted.

7. Press the Enter key to complete the master reset, or press the Esc key to abort.

8. After several seconds (which can grow to several minutes if a very large number of 
measurements have been saved in the instrument), the instrument reboots.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Secure Data, Option 7 4-5 Frequency Blanking

MS20xxC UG PN: 10580-00305  Rev. N 4-5

4-5 Frequency Blanking 
With Option 7 enabled, you have the ability to blank the frequency values that are displayed 
on the screen, as shown in Figure 4-1. This extra security measure allows you to use the 
instrument in any environment with sensitive frequency information blanked from the 
screen. To enable frequency blanking, navigate to the Reset menu and toggle the 
Frequency Blanking button to On (Shift-8 (System), System Options, Reset). The Reset menu 
and the Frequency Blanking button are shown in Figure 4-2. 

 

Figure 4-1. Frequency Blanking Turned On

Warning

Note that user files can still be stored to an external USB drive, and that frequency 
information is not blanked in those files. You must therefore ensure that no 
external USB devices are used to unintentionally store measurement or setup files 
when working with secure frequencies. Also, frequency information is not blanked 
from the SCPI commands that are used to remotely control the instrument. It is 
therefore up to you to ensure that no remote connections are made to the 
instrument when frequency information is being protected.
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After frequency blanking is enabled, you are not able to restore the frequency readouts. This 
feature was designed as an added security measure to ensure that the sensitive frequency 
information is protected and cannot be recovered. Following is a list of the security measures 
that have been taken to protect the frequency information:   

1. Turning off frequency blanking presets the instrument (and the frequencies) to the 
factory default settings.

2. Turning off the instrument presets the instrument to the factory default settings and 
turns off frequency blanking.

3. Presetting the instrument turns off frequency blanking and restores the factory default 
settings.

4. Frequency blanking is available only with Option 7 to ensure that user files and 
calibration files are not stored in the internal memory of the instrument. 

When you have completed making your measurements with frequency blanking turned on, 
simply turn off frequency blanking or turn off the instrument, and you can be assured that 
your sensitive frequency information cannot be restored or viewed by any other user.

Figure 4-2. Frequency Blanking Menu
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Chapter 5 — File Management

5-1 Introduction
This chapter describes the file management features of the VNA Master and describes the 
File menu. The submenus under this menu allow you to save, recall, copy, and delete files in 
the internal memory or an external USB flash drive.

5-2 File Types 
Following are some filename extensions that are used in the VNA Master. Some file types are 
option dependent and may not appear in your instrument.

*.afp AM/FM/PM analyzer measurements, filename.afp

*.cs  Channel Scanner measurements, filename.cs

*.csv Text file with Comma Separated Values (CSV), filename.csv

*.hipm High Accuracy Power Meter measurements, filename.hipm

*.ia Interference Analyzer measurements, filename.ia

*.jpg JPEG images, filename.jpg

*.lim Limit lines, filename.lim 

(Limit lines are available only in Spectrum Analyzer mode.) 

*.mna Measurements, filename.mna

*.s2p S2P (SnP), 2-Port scattering parameters measurements, filename.s2p

*.spa Spectrum Analyzer measurements, filename.spa

*.stp Setups, filename.stp

*.txt Text file with tab separated values, filename.txt

 

Note

S2P is a standard ASCII text file format that is used for scattering parameters from 
a 2-Port measurement. This is a subset of SnP (where n equals the number of 
ports). An S2P file can be used as input for signal analysis. The VNA Master 
generates S2P files even for one-port measurements by filling the unused columns 
with zeros.
The CSV and Text files contain setup information and final formatted data that are 
shown on the instrument display screen. This file information includes any 
post-processing that was done on the data (smoothing, trace math, time domain, 
and so forth). These files contain the data for any traces that are displayed, 
including the memory traces. They also contain the markers that are turned on 
when the file is saved. 
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5-3 Managing Files 
Press the Shift key then the File (7) key on the number keypad to display the File menu. 
Follow the additional steps below.

Save Files
Set the Save Location 
Press Save, then the Change Save Location key and select the location to save files. You can 
save files to the internal memory or to an external USB flash drive. You can also create new 
folders. If an external USB flash drive is connected or disconnected, press Refresh Directories 
to update the location tree. Press the Set Location key to store the save location.

Save Measurement As
The Save Measurement As key is used to quickly save measurements with a specific file 
name. The VNA Master saves the measurement with the latest file name that was used to 
save a measurement and with a number that is automatically incremented and appended to 
the end of the file name. For instance, if the last measurement was saved with the name 
System Return Loss, Save Measurement As saves the next measurements as System Return 
Loss_#1, System Return Loss_#2, and so forth. The file name can be changed using the Save 
dialog box (Figure 5-1).

Save a Measurement
Press the Save Measurement key and enter the name for the measurement file. The 
measurement file can be stored as .MNA.

Save a Setup 
Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 
by using the Change Type key, and then press Enter to save.

Save a Measurement Screen as JPEG 
Press the Save submenu key, type a name for the JPEG file, confirm that the file type is 
JPEG, and press Enter to save.

Note When navigating through the File menu, pressing the Esc key returns to the 
previous menu.
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Save Dialog Box
The save dialog box (Figure 5-1) is used to store files in internal memory or on an external 
USB flash drive. The file type, file name, and save location are set starting with this display. 
Refer to “Save Menu” on page 5-9 and “Save Location Menu” on page 5-10 for details.  

Note The figures in this user guide are typical examples. Images on your instrument 
may not match these examples.

Figure 5-1. Save Dialog Box
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Recall Files
The recall menu enables you to view all of the Measurement and Setup files in the internal 
memory and in an external USB flash drive. The files that are displayed during Recall File 
operation will vary depending on the instrument mode. For example, spectrum analyzer files 
(*.spa) do not appear in this menu when the instrument is in VNA Mode.

You can sort the recall menu by name, date, or type. You can also choose to view only 
measurement files or setup files by pressing File Type on the Recall dialog box and then by 
selecting the file type that you want to view.

Recall a Measurement
From the File menu, press the Recall Measurement submenu key, select the measurement 
with the rotary knob or the Up/Down arrow keys, and then press Enter. 
Recall a Setup
Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file 
(.stp) with the rotary knob or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box 
The Recall dialog box (Figure 5-2) opens previously saved measurements and setups. Refer 
to the “Recall Menu” on page 5-13 for additional information. 

Figure 5-2. Recall Dialog Box
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Copy Files
The steps below describe copying a file from internal memory to an external USB flash drive. 
(Copying in the reverse from USB to internal memory is accomplished by using the 
Scroll Src Dst submenu key.) Select the files to copy in the top window and the location for the 
files (to be copied) in the bottom window (Figure 5-3). Refer to the “Copy Menu” on page 5-14 
for additional information.

1. Insert a USB drive into either USB Type A port of the VNA Master. 

2. From the File main menu, press the Copy submenu key. The Copy menu and Copy 
dialog box are displayed.

3. Select the files that are to be copied. To select multiple files, highlight the first file, then 
press the Select or De-Select key to keep the file selected. The selected file is outlined in 
blue. Repeat with all the files that are to be copied. To display files in a folder, select the 
folder and press the Enter key.

4. Press the Scroll key and highlight the USB drive in the lower window using the 
Up/Down arrow keys. The Scroll submenu key toggles between source and destination, 
Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the USB flash drive.

Figure 5-3. Copy Dialog Box
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Delete Files 
Press the Delete submenu key. Highlight the file to be deleted with the Up/Down arrow keys. 
Press the Select or De-Select key. Selected files are outlined in blue. Press the Delete key and 
then press Enter to delete the selected file.

Delete Dialog Box
Press the Delete submenu key to open the Delete dialog box (Figure 5-4). The menus allow 
sorting by file type, name, and saved date. Refer to the “Delete Menu” on page 5-15 for 
additional information. 

Figure 5-4. Delete Dialog Box
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5-4 File Menu Overview  
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 5-5. File Menu
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5-5 File Menu  
Key Sequence: File

 

Save Measurement As: Press this submenu key to save the current setup 
with a user defined filename. The default filename is changed using the Save 
menu. To change the default filename, type in a new filename with the number 
keyboard and press Enter. After a few seconds, the screen returns to File 
menu. Press the Save Measurement As key again and the new file name is 
used. 
Save Measurement: Press this key to display the “Save Menu” on page 5-9. 
Measurements can be saved to internal memory or to a USB flash drive. The 
saved measurement can be named by using the Save menu keys. By default, 
measurements are saved to internal memory in a directory named /user. The 
save destination is set with the “Save Location Menu” on page 5-10.
Save: Press this key to display the “Save Menu” on page 5-9. Measurements 
can be saved to internal memory or to a USB flash drive. The saved setup, 
measurement, or JPEG file can be named in the Save menu. By default, 
measurements are saved to internal memory in a directory named /user. The 
save destination is set with the “Save Location Menu” on page 5-10.

Save on Event: Press this key to display the “Save On ... Menu” 
on page 5-12. This Save on Event submenu key is displayed only in 
Spectrum Analyzer and Interference Analyzer modes (models MS203xC).
Recall Measurement: Press this key to display the “Recall Menu” 
on page 5-13. This menu is for recalling measurements from internal memory 
or from a USB flash drive.
Recall: Press this key to display the “Recall Menu” on page 5-13. This menu 
is for recalling measurement or setup data from internal memory or from a 
USB flash drive.
Copy: Press this key to display the “Copy Menu” on page 5-14. The Copy 
menu is for copying files or folders from internal memory or a USB flash drive.
Delete: Press this key to display the “Delete Menu” on page 5-15 and a 
selection box that shows the setup and measurement names and the type, 
date, and time that the information was saved. Use the rotary knob or the 
Up/Down arrow keys to highlight the file that is to be deleted, and then press 
the Delete submenu key, then press Enter. Press the Esc key to cancel the 
operation. Note that deleted files cannot be recovered.

Figure 5-6. File Menu
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Save Menu  
Key Sequence: File > Save 

a b c: Use the top five submenu keys to enter letters and symbols in 
filenames. Press the Shift key for uppercase letters.

Use the Left/Right Arrow keys to move left and right within the text. 
Use the Back Space submenu key to move left, deleting characters.

Back Space: Press this submenu key to delete characters to the left.
Change Save Location: Press this submenu key to open the “Save Location 
Menu” on page 5-10.

Change Type Setup/JPEG/... Press this submenu key to select among the 
various file types available for setup and measurement data. This key also 
opens the File Type menu with a submenu key to select Full screen or Graph 
Only images for JPEG file types.

Figure 5-7. Save Menu
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Save Location Menu  
Key Sequence: File > Save > Change Save Location  

Sort By
Name Type Date: Press this submenu key to sort the folders by Name, 
Type, or Date. 
Sort Order
Ascend Descend: Press this submenu key to display the folder names in 
ascending or descending order.
Create Folder: Press this submenu key to create a new folder in the 
highlighted location or folder. Name the new folder in the create directory 
dialog box.

Set Location: Press this submenu key to set the current location for saving 
files and then return to the “Save Menu” on page 5-9.

Refresh Directories: Press this submenu key to update the display.

Figure 5-8. Save Location Menu

Figure 5-9. Select Save Location Dialog Box
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File Type Menu  
When saving a file, use this menu to change the file type. Typical file types are shown in 
Figure 5-11 and Figure 5-12. Because displayed file types depend upon instrument mode and 
installed options, your instrument may not display the same file types.

Key Sequence: File > Save > Change Type   

JPEG Capture
Full Graph Only: Toggling this submenu key to Full sets the VNA Master 
to save the file with measurement data. Toggling to Graph Only saves the file 
as an image of the screen.

Figure 5-10. File Type Menu

Figure 5-11. Select File Type List Box (Spectrum Analyzer Mode)  

Figure 5-12. Select File Type List Box (VNA Mode)  

JPEG Capture

Full       Graph Only

File Type

Select File Type
Setup
Measurement
JPEG
Limit Lines
KML 2D
KML 3D
Mapping Tab Delimited

Select File Type
Measurement
Setup (with CAL)
Setup (without CAL)
S2P − Real/Imag
S2P − Lin Mag/Phase
S2P − Log Mag/Phase
Text (VNA only)
CSV (VNA only)
JPEG

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



5-5 File Menu File Management

5-12 PN: 10580-00305  Rev. N MS20xxC UG

Save On ... Menu  
In Spectrum Analyzer and Interference Analyzer modes, this menu is used to auto save 
measurements to internal memory after specific events occur. 

Key Sequence: File > Save On Event 

... Crossing Limit
On Off: Press this submenu key to toggle the Crossing Limit On or Off. 
When On, measurements are saved to internal memory when the 
measurement has crossed a defined limit line that has been created with the 
Limit menu.
... Sweep Complete
On Off: Press this key to toggle the Sweep Complete setting On or Off. 
When On, measurements are saved to internal memory after the current 
sweep is complete. When Off, a measurement is saved after every sweep.
Save Then Stop
On Off: Press this key to toggle the Save Then Stop setting On or Off. 
When On, the sweep is stopped after a measurement is saved. When Off 
with Sweep Complete On, a measurement is saved after every sweep.
Clear All: Press this key to turn Off all three save-on-event keys:

Crossing Limit
Sweep Complete
Save Then Stop

Back: Press this key to return to the “File Menu” on page 5-8.

Figure 5-13. Save On ... Menu
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Recall Menu  
This menu and its dialog box are used to select the location from which the VNA Master 
recalls a file. Select folders or locations with the Up/Down arrow keys or the rotary knob. 

Key Sequence: File > Recall 

Use these menu keys to change the way files are listed in the Recall dialog 
box. Navigate to the desired file, then press Enter to recall.
When recalling a saved setup, all current instrument settings are replaced by 
the stored setup information. When recalling a saved measurement and 
multiple traces are displayed, parameter settings shown on the instrument 
screen may reflect those of the recalled trace or the active trace, depending 
on the measurement mode or other factors.
Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Recall dialog box.
Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.
File Type: Press this key to open the Select File Type list box. Press the 
desired file type on the list, then press Enter to apply the selection. JPEG 
image files cannot be recalled and are not listed.

Alternatively, you can select directly from the Filetype drop down list in the 
Recall dialog box.
Refresh Directories: Press this key to update the file list after connecting or 
disconnecting an external USB drive.

Figure 5-14. Recall Menu
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Copy Menu  
This menu and dialog box are used to copy folders and files. Select folders or files with the 
Up/Down arrow keys or the rotary knob. Highlight a folder and press Enter to view the 
contents. You can all use the Arrow keys. Right Arrow opens a folder to view files or 
subfolders. Left Arrow closes a folder (if it has files or subfolders).

Key Sequence: File > Copy 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Copy dialog box.
Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.
File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the selection.
Alternatively, you can select directly from the Filetype drop down list in the 
Copy dialog box.
Refresh Directories: Press this key to update the file list after connecting or 
disconnecting an external USB drive. 

Scroll
Src Dst: Press this key to shift navigation control between the source and 
destination panes in the Copy dialog box. See Figure 5-3.
Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.
Copy: Copies the selected files and folders, highlighted in blue in the top 
pane of the Copy dialog box, to the selected location in the bottom pane. If a 
file by the same name already exists in the destination location, an Error 
message is displayed, prompting you to press Enter to overwrite, or Esc to 
skip the conflicting file.

Figure 5-15. Copy Menu
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Delete Menu  
This menu and dialog box are used to delete folders and files. Select folders or files with the 
Up/Down arrow keys or the rotary knob. The Delete dialog box is shown in Figure 5-4 
on page 5-6.

Key Sequence: File > Delete 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Delete dialog box.
Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.

File Type: Press this key to open the Select File Type list box. Press the 
desired file type on the list, then press Enter to apply the selection.
Alternatively, you can select directly from the Filetype drop down list in the 
Delete dialog box.

Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.
Delete: Deletes the selected files or folders, which are highlighted in blue. In 
the confirmation box, press Yes to delete, No to cancel. You can also press 
Esc to cancel the deletion. 
Refresh Directories: Press this key to update the file list after connecting or 
disconnecting an external USB drive.

Figure 5-16. Delete Menu
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Chapter 6 — System Operations 

6-1 Introduction
This chapter describes the VNA Master system operations.

• “System Menu Overview” on page 6-2

• “System Menu” on page 6-4

• “Preset Menu” on page 6-14

• “Power On Self Test” on page 6-14

• “Firmware Update” on page 6-15

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement 
Guides that are listed in Appendix A.
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6-2 System Menu Overview  
To access the System menu, press the Shift key, then the System (8) key. Menu maps 
illustrated in this document typically show all possible submenu keys. Some keys may appear 
only under certain conditions, such as installed options and current measurement mode. 

Figure 6-1. System Menu Map
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6-3 Application Options Menus 
Application Options are specific to each operating mode, such as VNA or SPA (refer to 
“Application Options Menu (VNA Mode)” on page 6-5 and “Application Options Menu (SPA 
Mode)” on page 6-7). Refer to the measurement guides for other Application Options. 

Figure 6-2. Application Options Menus

Back

Time Domain Options

Reflection Calc in Time

One Way   Round Trip

Gate Coupled

On               Off

Domain Processing

Auto       BP Only

Back

Auto

Fixed

Mode

Back

Options

Units

m                    ft

Trace Label

On               Off

Meas Gain Range

Auto

External Reference

Off          10 MHz

Time Domain

VNA

Back

Options

Impedance

50 Ohm 75 Ohm Other

Auto Ref Level

SPA

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



6-4 System Menu System Operations 

6-4 PN: 10580-00305  Rev. N MS20xxC UG

6-4 System Menu   
Key Sequence: Shift, System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures, and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.
Self Test: Press this submenu key to run a series of tests that are related to 
the performance of the motherboard hardware. Press the Esc key to abort at 
any time. The display lists a summary of those tests that have passed. If any 
test fails, then all of the performed tests are listed with Pass/Fail notification. 
If the Self Test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, contact your Anritsu Service 
Center and report the test results. Press Esc or Enter to return to normal 
operation.

Application Self Test: Press this submenu key to run a series of tests that 
are related to the performance of the instrument hardware and that are 
specific to the current instrument application. Because high power levels are 
present at the ports during this self test, diconnect any sensitive devices 
before proceeding. Press the Esc key to abort, or press the Enter key to 
continue. The display lists a summary of those tests that have passed. If any 
test fails, then all of the performed tests are listed with Pass/Fail notification. If 
any test fails, contact your Anritsu Service Center and report the test results.
GPS: Press this submenu key to open the GSP Menu. Refer to 
Chapter 7, “GPS Receiver, Option 31” for additional information.
Application Options: Submenu keys are specific to each measurement 
mode: “Application Options Menu (VNA Mode)” on page 6-5, 
“Application Options Menu (SPA Mode)” on page 6-7.
System Options: Press this submenu key to open the “System Options 
Menu” on page 6-8.

Figure 6-3. System Menu
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6-5 Application Options Menu (VNA Mode)   
This menu is specific to the VNA application. 

Key Sequence: Shift, System (8) > Application Options 

Standard VNA menus selected.

Units
m ft: Press this submenu key to toggle the units setting to metric (meters, 
or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or press the 
Esc key to return to normal operation without changing the setting.

External Reference: Press this key to toggle between the two choices of 
turning Off the external reference or selecting the external reference.
Trace Label
On Off: Press this key to toggle the trace labels On or Off.
Meas Gain Range: Press this key to open the “Meas Gain Range Menu 
(VNA Mode)” on page 6-6. Then select Auto or Fixed. 

Time Domain
On Off: Press this submenu key to open the “Time Domain Options Menu 
(VNA Mode)” on page 6-6.

Back: Press this key to return to the “System Menu” on page 6-4.

Figure 6-4. Application Options Menu (VNA Mode) 
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6-6 Meas Gain Range Menu (VNA Mode)  
Key Sequence: Shift, System (8) > Application Options > Meas Gain Range 

6-7 Time Domain Options Menu (VNA Mode)  
This menu is available only when Option 2, Time Domain, is installed. More information is 
available in the Vector Network Analyzer Measurement Guide (listed in Appendix A).

Key Sequence: Shift, System (8) > Application Options > Time Domain

Auto: Press this key to set the Measurement Gain Range Mode to Auto. In 
this mode, the instrument adjusts the gain automatically to provide the best 
overall system performance (dynamic range and high level noise). 

Fixed: Press this key to set the Measurement Gain Range Mode to Fixed. In 
this mode, the gain of the instrument is always set to the low gain setting. For 
most applications, Auto mode is recommended. For certain types of filter 
measurements (mostly in the range less than 500 MHz), the instrument may 
toggle between low gain and high gain modes as the signal level rises from 
the noise to the pass band of the filter, resulting in extra ripple. Setting the 
Gain Range to Fixed may address that problem.

Back: Press this key to return to the “Application Options Menu (VNA 
Mode)”.

Figure 6-5. VNA Mode (Measurement Gain Range) Menu

Reflection Calc in Time
One Way Round Trip: Press this submenu key to toggle the setting for the 
calculation method that is used in the time domain (not distance) reflection 
measurements. The method can be either One Way (divide the total time 
by 2) or Round Trip.
Gate Coupled
On Off: Press this key to toggle the gate coupling On or Off. When set to 
On, the gate settings (start, stop, and so forth) for all traces are the same. 
When set to Off, each trace has a gate whose settings are independent of any 
of the other gates that are being used.
Domain Processing
Auto BP Only: Press this key to toggle domain processing to Auto or to 
BP Only. In Auto, the instrument selects Low Pass processing whenever 
possible and switches to Band Pass if not possible. In BP Only, the setting will 
never be Low Pass.

Back: Press this key to return to the “Application Options Menu (VNA Mode)” 
on page 6-5.

Figure 6-6. Application Options Menu (VNA Mode) 
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6-8 Application Options Menu (SPA Mode)   
This menu is specific to the Spectrum Analyzer application.

Key Sequence: Shift, System (8) > Application Options 

SPA mode selected 

Impedance
50 Ohm 75 Ohm Other: Press this submenu key to toggle the impedance 
setting to 50 ohm, 75 ohm, or Other impedance value. Selecting 75 ohm 
selects the 7.5 dB loss of the Anritsu 12N50-75B adapter. For other adapters, 
select Other and enter the appropriate loss value.

Auto Ref Level: Press this submenu key to adjust the position of a displayed 
signal so that it is approximately two divisions down from the top of the sweep 
window, if possible. When the key is pressed, the reference level is adjusted 
once. Auto Ref Level may turn off the low-noise front-end preamplifier, but 
does not turn it on. It has no effect on vertical scaling.

Back: Press this key to return to the “System Menu” on page 6-4.

Figure 6-7. Application Options Menu (SPA Mode)
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6-9 System Options Menu  
Key Sequence: Shift, System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without making 
changes.
Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box, where you can set the instrument 
IP address. For details, refer to “Ethernet Configuration” on page G-1.
Language: Press this submenu key to open a list box and select a built-in 
language for the instrument display. Press Enter to apply the change, or 
press Esc to cancel.

The languages that are currently available are: English, French, German, 
Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You 
can edit non-English language captions using Master Software Tools (MST). If 
a mode does not have language translations available, then English is the 
default language.

Caution: A firmware update or any instrument reset will overwrite 
modifications you may have made in any of the language files.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 6-9, allowing brightness control and the selection of different display 
attributes.

Name: Press this submenu key to open the Unit Name dialog, where you can 
enter a name for the instrument. The VNA Master can be named by using the 
text entry controls as described in “Text Entry” on page 2-15. Press Enter to 
save the name.
The assigned instrument name appears in measurement files, setup files, 
limit line files, and MST reports. It is displayed on the browser title bar when 
the instrument is connected to a remote PC or mobile device.

Volume: Press this submenu key to view or adjust the speaker volume. The 
current volume setting is displayed in the Volume input box. Use the numeric 
keypad, the Up/Down arrow keys, or the rotary knob to change the value, and 
press Enter to apply the change.
Reset: Press this submenu key to open the “Reset Menu” on page 6-11.
More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 6-12.

Figure 6-8. System Options Menu (1 of 2)

More

Reset

System Options

Date
&

Time

Ethernet

Config

Language

Name

Volume

Display

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



System Operations 6-10 Display Settings Menu

MS20xxC UG PN: 10580-00305  Rev. N 6-9

6-10 Display Settings Menu     
Key Sequence: Shift, System (8) > System Options > Display  

Brightness: Opens the “Brightness Settings Menu” on page 6-10.

Display Blank: Opens the message box illustrated in Figure 6-10. Press 
Enter to turn off the display, or press Esc to abort. To turn the display back on, 
press any key (except the Power button) three times in rapid succession. A 
power cycle also turns the display back on.
Default Colors: Sets the display colors to the factory defaults. Used for 
normal viewing.
Black on White: Sets the display colors to black on a white background. 
Used for printing and viewing in broad daylight conditions.

Night Vision: Sets the display to a red-tinted color on a black background. 
This setting is optimized for nighttime viewing.

High Contrast: Increases the black and white contrast of the default display. 
This setting is used in challenging viewing conditions.
Color on White: Sets the display background to white, the grid to gray, and 
leaves sweep data in color. This setting is used for printing and viewing in 
broad daylight conditions.

Back: Press this key to return to the “System Options Menu” on page 6-8.

Figure 6-9. Display Settings Menu

Figure 6-10. Display Blank Message Box
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6-11 Brightness Settings Menu  
Key Sequence: Shift, System (8) > System Options > Display > Brightness  

The brightness of the display can be adjusted to optimize viewing under a 
wide variety of lighting conditions.
Brightness: Press this submenu key to open the Brightness Editor window, 
where you can adjust the display brightness level from 0 to 100, with 100 
being the brightest. See Figure 6-12. Use the rotary knob to adjust the value 
in increments of 5, or press the Up/Down arrow keys to change the value in 
increments of 25. Press the Left or the Right arrow key to jump to 0 or 100, 
respectively. Press Enter to accept the change. All display elements on the 
instrument screen are affected by the Brightness setting.
Auto Dim
On Off: Press this key to toggle the display auto-dimming feature on and 
off. Enabling auto-dim can extend battery life.

Auto Dim Delay: Press this key to adjust the amount of idle time, from 1 to 
15 minutes, before the instrument display goes dim. Use the arrow keys or the 
rotary knob to adjust the value in increments of 1. You can also use the 
numeric keypad, then press Enter. Out-of-range values are ignored.
Auto Dim Brightness: Press this submenu key to select the brightness 
percentage level of the display when it is dimmed. Use the arrow keys or the 
rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can 
also use the numeric keypad, then press % or the Enter key. Out-of-range 
values are ignored.
Back: Press this key to return to the “Display Settings Menu” on page 6-9.

Figure 6-11. Brightness Settings Menu

Figure 6-12. Brightness Editor Input Box
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6-12 Reset Menu  
Key Sequence: Shift, System (8) > System Options > Reset 

Factory Defaults: Press this key to restore the instrument to the default 
settings for all measurement modes and system settings, including 
connectivity, language, and the display and audio settings. The instrument will 
power cycle when the operation is complete. Press the Enter key to initiate 
the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the 
instrument by pressing Power while holding down the Esc key until the 
Anritsu splash screen is displayed.

Master Reset: Press this submenu key to restore the instrument to factory 
defaults as described above and to delete all user files from the instrument 
internal memory. The instrument will power cycle when the operation is 
complete. Press Enter to initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning on the 
instrument by pressing Power while holding down the System (8) key 
until the Anritsu splash screen is displayed.

Update Firmware: This key is used for updating the instrument firmware. 
Refer to “Firmware Update” on page 6-15 for detailed instructions.
Back: Press this key to return to the “System Options Menu” on page 6-8.

Figure 6-13. Reset Menu
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6-13 System Options 2/2 Menu    
Key Sequence: Shift, System (8) > System Options > More   

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting 
between All Modes and Not Shared. Select All Modes to have the current 
center frequency setting and power offset setting carried over when changing 
measurement modes. This function is not applicable to measurements that do 
not have a center frequency or power offset setting or to measurements in 
which the current center frequency or power offset setting is outside the range 
of the new measurement.
Note: This key is used only for spectrum analysis.
Set Remote Access Password: Press this submenu key to open the 
Password text box (see Figure 6-15) and Text Entry menu. Passwords may 
contain digits, uppercase and lowercase letters, and the symbols: - _ + . 
(hyphen, underscore, plus, period). Press Enter to save or Esc to cancel.

Connecting to the instrument via Master Software Tools (v2.21.1 or later) will 
require the set password. An empty Password field means the instrument is 
not password-protected. The password is also removed following a Master 
Reset, Factory Defaults reset, or a firmware update.
Power–On: Press this submenu key to display the “Power–On Menu” 
on page 6-13.
Back: Press this submenu key to return to the “System Options Menu” 
on page 6-8.

Figure 6-14. System Options 2/2 Menu

Warning Do not set a remote access password when using SCPI commands to 
communicate with the instrument.

Figure 6-15. Remote Access Password Text Box
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6-14 Power–On Menu  
Key Sequence: Shift, System (8) > System Options > More > Power–On

Power Switch: Press this submenu key to set the instrument for normal use 
of the On/Off button on the instrument front panel.
When DC Applied: Press this submenu key to set the instrument to 
automatically restart when DC power is applied to the External Power 
connector (item “11” in Figure 2-13 on page 2-20). Refer to “External Power” 
on page 2-25.

Back: Press this key to return to the “System Options 2/2 Menu” 
on page 6-12.

Figure 6-16. Power–On Menu
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6-15 Preset Menu  
Key Sequence: Shift, Preset (1) 

6-16 Power On Self Test    
At power On, the VNA Master runs through a series of quick checks to ensure that the system 
is functioning properly.

From the “System Menu”, the System Self Test (“Self Test” on page 6-4) runs a series of tests 
that are related to the instrument itself. The Application Self Test (“Application Self Test” 
on page 6-4) runs a series of tests that are related to the current operating mode of the 
instrument. 

If the VNA Master is within the specified operating range with a charged battery, and if the 
self test fails, contact your Anritsu Service Center (anritsu.com/contact-us). 

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed. 

3. Press Esc to continue.

Preset: This key resets all parameter settings for the current measurement 
mode to their factory default values, and switches the display to the default 
view for that mode. Measurement settings specific to other modes, or 
applications, are not affected.

Save: Press this key to open the Save dialog box (Figure 5-1) to name and 
save the current operating settings, allowing them to be recalled later to 
return the instrument to the state it was in at the time the setup was saved.
Note: Set the File type as Setup. Refer to “Save Menu” on page 5-9 for 
details.
The saved setup can be named in the Save dialog. Use the Shift key to 
toggle between uppercase and lowercase. Use the Left/Right directional 
arrows to move the cursor position. Press Enter to save the setup.

Recall: Press this key to select and recall a previously stored instrument 
setup using the “Recall Menu” on page 5-13. Use the Up/Down arrow keys 
or the rotary knob to highlight the saved setup, and press Enter. All current 
instrument settings are replaced by the stored setup information. 

Figure 6-17. Preset Menu
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6-17 Firmware Update 
To update your Anritsu instrument firmware, use a high quality USB memory device with at 
least 250 MB of free space and FAT32 file system format.

1. Insert the memory device into your PC or laptop.

2. From a browser, go to the following Anritsu Products page:

https://www.anritsu.com/en-US/test-measurement/rf-microwave/vector-network-analyz
ers-handheld

3. If the Web page lists more than one product, find your instrument model number and 
click the link.

4. On the product page, press the Downloads button.

5. Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware 
Revision/Release History link to download a document detailing current and past 
firmware changes.

6. Click on the link Firmware Update for the VNA Master MS20xxC.

7. Click the Download button, then choose Save or Save As. Do not run the executable file 
directly from the Web page.

8. Go to the Save location designated in Step 7 and double-click the installer file, 
Model_Ver_USBLoader.exe.

9. In the Firmware Update dialog, click to view, then accept the software license 
agreement.

10. Click Browse and select the Removable Disk drive where the USB device is inserted.

11. Click Prepare USB Memory Stick to create the firmware update USB device.

12. After the firmware update tool has finished, click through the final steps in the 
Firmware Update dialog to close the installer program.

13. Eject the memory device from the computer. 

14. Turn off the VNA Master and insert the USB memory device into the instrument.

15. Make sure the VNA Master is plugged into an AC power source and not running on 
battery alone, then turn on the instrument.

16.  At bootup, the instrument should detect new firmware on the USB device and ask if 
you wish to upgrade. Press Yes.

17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19. 

Note The file structure created on the USB memory device by the installer program is 
necessary for a successful firmware update and must not be altered in any way.

Note

If the same firmware code as contained on the USB device is already loaded on 
the instrument, a message indicating that firmware update is skipped will display 
briefly on the instrument screen.

If the firmware update on the memory device does not match your instrument 
model, an error message will display briefly, indicating that it is not compatible.
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18. If there is no error but the instrument does not enter upgrade mode automatically:

a. Press Shift > System (8) > System Options > Reset > Update Firmware.

b. Press Load Firmware at the bottom left of the instrument screen.

c. Press Update Application Firmware.

d. The Firmware Update dialog opens.

19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.

• Save none: No attempt is made to save any user data.

• Save user data: User data is saved to the selected external media device.

• Save & restore user data: User data is saved to the selected external media 
device. The instrument also attempts to restore the files to the instrument after 
the update. 

20. Press Enter.
21. Press Enter again to confirm your intention to proceed with the firmware upgrade.

To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and 
select an application from the Mode Selector list in order to exit upgrade mode and 
resume normal instrument operation. 

22. After the update is complete, the instrument should reboot automatically. 

Warning Some user data may be lost if not enough memory space is available on the 
selected device.

Warning
You cannot stop the upgrade once it has started. To avoid potential permanent 
damage, do not turn off the instrument or remove the USB memory device during 
the firmware update.

Note

If the instrument turns off and does not restart on its own, remove the USB memory 
device and turn on the instrument by holding down the System (8) key, then 
pressing the Power button. Keep pressing System (8) until the Anritsu splash 
screen is displayed.
Be sure to use this key combination in order to perform a Master Reset while 
turning on the instrument. Pressing the Power button alone may put the instrument 
in an unrecoverable error state.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



MS20xxC UG PN: 10580-00305  Rev. N 7-1

Chapter 7 — GPS Receiver, Option 31

7-1 Introduction    
The VNA Master is available with a built-in GPS receiver feature (Option 31) that can 
provide latitude, longitude, altitude, and UTC timing information. This option also enhances 
frequency reference oscillator accuracy in the spectrum analyzer mode. When GPS is actively 
locked to satellites, this information is saved with all saved measurements and can be 
displayed with Master Software Tools. No accuracy specifications apply if no GPS satellites 
are acquired.

7-2 Activating the GPS Feature     
Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

1. Press the Shift key, then the System (8) key on the numeric keypad to display the 
System menu.

2. Press the GPS submenu key.

3. Activate GPS by pressing the GPS On/Off submenu key so that On is underlined. When 
GPS is first turned On, the GPS icon is displayed in red to indicate that fewer than four 
satellites are currently being tracked.

Note

The VNA Master Technical Data Sheet provides a list of the options and 
measurements that require GPS (Option 31). In addition to having Option 31 
installed, a GPS antenna is required. Refer to the instrument Technical Data Sheet 
for compatible GPS antennas.

Figure 7-1. GPS Icon, Red

GPS
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4. When the GPS receiver is tracking at least four satellites, the GPS icon changes to 
green. Latitude and longitude information is displayed in the title bar at the top of the 
display. Acquiring satellites may take as long as three minutes.

5. Press the GPS Info submenu key to display the following information:

• Tracked satellites

• Latitude and longitude

• Altitude

• UTC timing information

• Fix available

• Almanac complete

• Antenna and receiver status

• GPS antenna voltage and current

Refer to “GPS Menu” on page 7-4 for details on the above GPS Info items.

After GPS location fix is attained, the internal reference oscillator begins to correct its 
frequency to match the GPS standard. After the internal frequency is adjusted to match the 
GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu, 
which is displayed on the left side of the measurement display. When the GPS feature is not 
enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected 
external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of 
better than 50 ppb (parts per billion).

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside with no obstructions.

If no GPS is connected, the Frequency Reference annotation reads Int Std Accy. When GPS is 
connected, with a fix, and the tuning process has completed (which may take a few minutes), 
the Frequency Reference annotation shows GPS Hi Accy. If GPS is subsequently lost (for 
example, GPS is turned off, disconnected, or there is no signal due to physical obstruction), 
the instrument goes back to Int Std Accy after a few moments.

Figure 7-2. GPS Icon, Green

GPS
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7-3 Resetting GPS
To reset the GPS, press the Reset submenu key. The green GPS icon shows a red cross mark 
when satellite tracking is lost after tracking four or more satellites. The GPS latitude and 
longitude are saved in the instrument memory until the VNA Master is turned off or until 
GPS is turned off by using the GPS On/Off key. 

7-4 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information
The GPS coordinates of a location can be saved along with a measurement trace. Refer to 
“Save Menu” on page 5-9 for more information. The current GPS coordinates will be saved 
with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information
If the GPS coordinates were saved with a measurement, the coordinates will be recalled when 
the measurement is recalled. Refer to “Recall Menu” on page 5-13 for more information on 
recalling a saved trace.

Figure 7-3. GPS Icon, Tracking Lost

GPS
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7-5 GPS Menu
Key Sequence: Shift, System (8) > GPS 

GPS: Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information.
Tracked Satellites: Shows the number of tracked satellites (three are 
required to retrieve latitude and longitude, four are required to resolve 
altitude). Generally, the larger the number of satellites tracked, the 
more accurate the GPS information.
Latitude and Longitude: Shows location in degrees, minutes, and 
seconds.

Altitude: Shows altitude information in meters.
UTC: Universal Coordinated Time.
Fix Available: The cold start search sets are established to ensure 
that at least three satellites are acquired within the first couple of 
minutes. When three satellites are found, the receiver will compute an 
initial fix (typically in less than two minutes). Fix Available: No means 
that the initial position has not been established.

Almanac Complete: The system almanac contains information about 
the satellites in the constellation, ionospheric data, and special system 
messages. In a cold start, the GPS receiver has no navigation data, so 
the receiver does not have a current almanac. A complete system 
almanac is not required to achieve a first position fix. However, UTC 
time is not correct until the almanac is complete, and the availability of 
the almanac can significantly reduce the time to first fix.
Antenna Status:
OK: Active antenna is connected and is working properly.
Short/Open: If an active antenna is in use, a short or open exists 
between the antenna and the connection. If this message is displayed, 
replace the antenna. If the message persists, try another Anritsu GPS 
antenna. If needed, contact your nearest Anritsu Service Center. If a 
passive antenna is in use, the message should display: Antenna OPEN 
Detected or Passive Antenna Used.

Receiver Status: Current status of the receiver.
GPS Antenna Voltage and Current: Shows voltage and current.

GPS Voltage: Press this submenu key to set the source voltage at 3.3 V or 
5 V, depending on the GPS receiver being used. The default setting is 3.3 V to 
prevent accidental damage to lower-voltage GPS antennas.

Reset: The Reset key sets the number of tracked satellites to 0 and erases 
any almanac data and saved coordinates. The process of searching for and 
reacquiring satellites will begin again.
Back: Press this submenu key to return to the “System Menu” on page 6-4.

Figure 7-4. GPS Menu
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Chapter 8 — Anritsu Tool Box

8-1 Introduction
The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu 
handheld RF instruments and a PC. The instrument connects to the computer via a USB, 
Ethernet, or serial port. Depending on the application selected, available functions range 
from the capture, transfer, and reporting of measurement data for trace analysis, to coverage 
and interference mapping, and the delivery of work instructions.

Tool Box applications are available for download from the Anritsu website at 
anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box. 
Click the link to one of the Tool Box applications, then click Downloads and choose either the 
Full Installer or Web Installer. There is no difference between the two if you run the installer 
without saving. If you elect to save, the Full Installer will download all Anritsu software 
needed in a single executable file, which allows you to perform the installation later on a 
computer with no Internet access required. The Web Installer is a much smaller file that will 
require Internet access to execute the software installation.

8-2 Software Installation
Whether running the installer directly or executing the saved file, follow the instructions on 
screen. The Setup screen illustrated in Figure 8-1 may change with the software version.

You will be asked to select which applications you wish to install. Not all instrument models 
are supported by every software tool. To view the list of instrument models supported by a 
Tool Box application, click the Instruments tab on the application Web page. 

Figure 8-1. Anritsu Tool Box Setup Wizard
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8-3 Anritsu Software Tool Box
The Anritsu Tool Box serves as a central location from which you can open a previously saved 
measurement, visit the Anritsu website, or launch an application. To open the Tool Box, 
either double-click the desktop shortcut or select Anritsu Tool Box from the Windows Start 
menu. On the Tool Box screen, hover the mouse pointer over any of the application icons to 
view a short description of the application. See Figure 8-2. 

Figure 8-2. Anritsu Tool Box Screen
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8-4 Software Tools
The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively, 
you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu 
Tool Box. For a detailed description of these features and how to perform specific tasks, refer 
to each application’s Help system. The program Help also lists the instrument models, 
measurement modes, trace types, and file types that are compatible with that application.

Line Sweep Tools (LST)
Line Sweep Tools is post-capture trace processing software designed for users who need to 
analyze and generate reports on large numbers of cable, antenna, and PIM traces. Software 
features include:

• Measurement plot data capture and transfer from the instrument to a PC

• Marker and limit line presets

• Return Loss, Distance-to-Fault, PIM analysis

• LMR Master and VNA Master Field Mode compatibility

• Plot overlay for comparison of up to ten traces of the same measurement type

• Plot area zooming

• A naming grid for renaming files, titles, and subtitles

• Automated report generation

• Output to printer or to PDF or HTML format

• Export of plot data to text, image, or VNA files

Master Software Tools (MST)
Master Software Tools is designed for users of Anritsu handheld spectrum analyzers, 
interference analysis tools, transmission testers, and backhaul testers. Supported functions 
include the following:

• Transfer of captured measurement data to and from a PC for storage and analysis

• RF Spectrum Analyzer traces

• RF Interference analysis

• Spectrum monitoring

• Transmitter signal quality tests

• T1, T3, and E1 backhaul tests

• Trace overlay features for comparing multiple Spectrum Analyzer measurements

• Limit lines and markers

• Script Master for the creation of automated test procedures

• Export of measurement data as text, graphic, or Comma Separated Value format (CSV) 
files

• Reports created in HTML format for use in other applications
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Appendix A — Supplemental 
Documentation

A-1 Introduction   
This appendix provides a list of supplemental documentation for VNA Master features and 
options. These measurement guides are available on the Anritsu website.     

Software applications are available for download at 
anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box.

Table A-1. Measurement Guides

Title Part Number

Vector Network Analyzer Measurement Guide 10580-00289
Spectrum Analyzer Measurement Guide
   – Interference Analyzer, Channel Scanner,
   – PIM Hunting,
   – AM/FM/PM Analyzer

10580-00349

Power Meter Measurement Guide
   – Power Meter, High Accuracy Power Meter

10580-00240

Table A-2. VNA Master Related Documents

Title Part Number

VNA Master MS20xxC Technical Data Sheet 11410-00548
Programming Manual 10580-00306
VNA Master MS20xxC Maintenance Manual 10580-00307
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Appendix B — Signal Standards

B-1 Introduction
This appendix provides a sample list of signal standards. This list can be used as a reference 
when making measurements with the VNA Master. 

Table B-1. Signal Standards

Signal Standard Center 
(MHz)

Span 
(MHz) Valid Channels

AMPS / EIA 553 - Uplink 859 70 1-799, 990-1023
AMPS / EIA 553 - Downlink 859 70 1-799, 990-1023
C-450 (P) - Uplink 463.5 21 1-800
C-450 (P) - Downlink 463.5 21 1-800
C-450 (SA) - Uplink 462.5 15 1-247
C-450 (SA) - Downlink 462.5 15 1-247
CDMA US Cellular - Uplink 859 70 1-799, 990-1023
CDMA US Cellular - Downlink 859 70 1-799, 990-1023
CDMA US PCS - Uplink 1920 140 1-1199
CDMA US PCS - Downlink 1920 140 1-1199
CDMA Korea PCS - Uplink 1810 120 1-599
CDMA Korea PCS - Downlink 1810 120 1-599
CDMA Japan / ARIB - Uplink 878.5 93 1-799, 801-1039, 1041-1199
CDMA Japan / ARIB - Downlink 878.5 93 1-799, 801-1039, 1041-1199
CDMA China - 1 - Uplink 916 88 0-1000, 1329-2047
CDMA China - 1 - Downlink 916 88 0-1000, 1329-2047
CDMA China - 2 - Uplink 910 76 0-1000
CDMA China - 2 - Downlink 910 76 0-1000
cdma2000 Class 0, Korea Cellular - Uplink 859 70 1-799, 990-1023
cdma2000 Class 0, Korea Cellular - Downlink 859 70 1-799, 990-1023
cdma2000 Class 0, N.A. Cellular - Uplink 859 70 1-799, 990-1023
cdma2000 Class 0, N.A. Cellular - Downlink 859 70 1-799, 990-1023
cdma2000 Class 1, N.A. PCS - Uplink 1920 140 0-1199
cdma2000 Class 1, N.A. PCS - Downlink 1920 140 0-1199
cdma2000 Class 2, (TACS Band) - Uplink 916 88 0-1100, 1329-2047
cdma2000 Class 2, (TACS Band) - Downlink 916 88 0-1100, 1329-2047
cdma2000 Class 3, (JTACS Band) - Uplink 878.5 93 1-799, 801-1039, 1041-1199
cdma2000 Class 3, (JTACS Band) - Downlink 878.5 93 1-799, 801-1039, 1041-1199
cdma2000 Class 4, Korea PCS - Uplink 1810 120 0-599
cdma2000 Class 4, Korea PCS - Downlink 1810 120 0-599
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cdma2000 Class 5, (NMT-450-20 kHz) - Uplink 472.5 43 1039-1473, 1792-2016
cdma2000 Class 5, (NMT-450-20 kHz) - 
Downlink 472.5 43 1039-1473, 1792-2016

cdma2000 Class 5, (NMT-450-25 kHz) - Uplink 439.5 57 1-300, 539-871
cdma2000 Class 5, (NMT-450-25 kHz) - 
Downlink 439.5 57 1-300, 539-871

cdma2000 Class 6, IMT-2000 - Uplink 2045 250 0-1199
cdma2000 Class 6, IMT-2000 - Downlink 2045 250 0-1199
cdma2000 Class 7, N.A. 700 MHz Cellular - 
Uplink 770 48 0-359

cdma2000 Class 7, N.A. 700 MHz Cellular - 
Downlink 770 48 0-359

ETACS - Uplink 916 88 0-1000, 1329-2047
ETACS - Downlink 916 88 0-1000, 1329-2047
GSM 900 - Uplink 897.4 40 1-124, 975-1023
GSM 900 - Downlink 942.4 40 1-124, 975-1023
GSM 1800 - Uplink 1747.4 80 512-885
GSM 1800 - Downlink 1842.4 80 512-885
GSM 1900 - Uplink 1879.8 80 512-810
GSM 1900 - Downlink 1959.8 80 512-810
JTACS - Uplink 878.5 93 0-1198 (even numbers only)
JTACS - Downlink 878.5 93 0-1198 (even numbers only)
MATS-E - Uplink 925 70 1-1000
MATS-E - Downlink 925 70 1-1000
N-AMPS / IS-88L - Uplink 859 70 1-799, 990-1023
N-AMPS / IS-88L - Downlink 859 70 1-799, 990-1023
N-AMPS / IS-88M - Uplink 859 70 1-799, 990-1023
N-AMPS / IS-88M - Downlink 859 70 1-799, 990-1023
N-AMPS / IS-88U - Uplink 897.5 147 1-799, 990-1023
N-AMPS / IS-88U - Downlink 897.5 147 1-799, 990-1023
NADC IS136 Cellular - Uplink 859 70 1-799, 990-1023
NADC IS136 Cellular - Downlink 859 70 1-799, 990-1023
NADC IS136 PCS - Uplink 1920 140 1-1199
NADC IS136 PCS - Downlink 1920 140 1-1199
NMT-411-25 kHz - Uplink 420.5 19 539-871
NMT-411-25 kHz - Downlink 420.5 19 539-871
NMT-450-20 kHz - Uplink 460.5 19 1039-1473
NMT-450-20 kHz - Downlink 460.5 19 1039-1473

Table B-1. Signal Standards

Signal Standard Center 
(MHz)

Span 
(MHz) Valid Channels

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Signal Standards B-1 Introduction

MS20xxC UG PN: 10580-00305  Rev. N B-3

NMT-450-25 kHz - Uplink 459 18 1-300
NMT-450-25 kHz - Downlink 459 18 1-300
NMT-470-20 kHz - Uplink 486.5 15 1972-2016
NMT-470-20 kHz - Downlink 486.5 15 1972-2016
NMT-900 - Uplink 925 70 1-1000
NMT-900 - Downlink 925 70 1-1000
NMT-900 (Offset) - Uplink 925 70 1025-2023
NMT-900 (Offset) - Downlink 925 70 1025-2023
NTACS - Uplink 878.5 93 1-1199
NTACS - Downlink 878.5 93 1-1199
PDC 800 Analog - Uplink 891.5 97 0-1680
PDC 800 Analog - Downlink 891.5 97 0-1680
PDC 1500 (JDC) - Uplink 1513 72 0-960
PDC 1500 (JDC) - Downlink 1513 72 0-960
PHS - Uplink 1906.5 23 1-77
PHS - Downlink 1906.5 23 1-77
SMR 800 - 12.5 kHz - Uplink 836 60 1-1199
SMR 800 - 12.5 kHz - Downlink 836 60 1-1199
SMR 800 - 25 kHz - Uplink 836 60 1-600
SMR 800 - 25 kHz - Downlink 836 60 1-600
SMR 1500 - Uplink 1483 60 1-479
SMR 1500 - Downlink 1483 60 1-479
TACS - Uplink 925 70 1-1000
TACS - Downlink 925 70 1-1000
UMTS/WCDMA - Uplink 1920 70 9600-9900
UMTS/WCDMA - Downlink 2110 70 10550-10850
UMTS/Region 2 - Uplink 1850 70 9250-9550
UMTS/Region 2 - Downlink 1930 70 9650-9950
802.11a 5170 84 34-161 (not all valid)
802.11b 2442 84 1-14
802.11 DS 2448 72 1-14
802.11 FH 2448.5 93 2-95
802.11g 2442 84 1-14

Table B-1. Signal Standards

Signal Standard Center 
(MHz)

Span 
(MHz) Valid Channels
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Appendix C — Error Messages

C-1 Introduction
This appendix provides a list of information and error messages that could be displayed on 
the VNA Master. If any error condition persists, contact your local Anritsu Service Center.

C-2 Reset Options
You can reset your VNA Master to Factory Defaults or use a Master Reset to return to the 
FULL Factory Default condition from the menu system or from the Off condition.

Reset Via Instrument Menus
From the VNA Master menu system, press the Shift key, then the System (8) key to open the 
System menu. Then press the System Options soft key to open the System Options menu. 
Then press the Reset soft key to open the Reset menu (refer to the Reset menu in Chapter 5 of 
the VNA Measurement Guide (listed in Appendix A). From the Reset menu, press either the 
Factory Defaults soft key or the Master Reset soft key.  

Reset from OFF Condition
You can also reset the VNA Master by turning it Off and then restarting under one of the 
following conditions:

Factory Defaults Reset:
Hold the Esc button while pressing the On/Off button. Continue holding the Esc button until 
the Anritsu splash screen appears. You can then release the button. The VNA Master starts 
up with Factory Default settings (refer to section “Reset Menu” on page 6-11). Throughout 
this appendix, this sequence is abbreviated as Factory Defaults (Esc+On).

Master Reset:
Hold the 8 key in the number keypad (also referred to as the System (8) key) while pressing 
the On/Off button. Continue holding the 8 key until the Anritsu splash screen appears. You 
can then release the key. The VNA Master starts up in FULL Factory Default condition (refer 
to section “Reset Menu” on page 6-11). Throughout this appendix, this sequence is 
abbreviated as Master Reset (System+On).

Caution 

Use of Master Reset (System+On), will permanently erase all user saved setups 
and measurement traces and will return the VNA Master to a full Factory Default 
condition. Be sure to make backup copies of any important files before proceeding 
with a Master Reset. If the error persists, contact your Anritsu Service Center.
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C-3 Self Test or Application Self Test Error Messages

Self Test
To run self test, press Shift and System (8) and then Self Test. Refer to the results window in 
Figure C-1, which summarizes the status of several key functions in the instrument that are 
common to all applications (note that your instrument display may differ from this image). If 
any subtest shows FAILED, then check that the battery level is adequate for operation, or 
check that the temperature is within acceptable limits. Reset to factory defaults with either 
Factory Defaults (Esc+On), or Master Reset (System+On).

   

Caution 

Use of Master Reset (System+On), will permanently erase all user saved setups 
and measurement traces and will return the VNA Master to a full Factory Default 
condition. Be sure to make backup copies of any important files before proceeding 
with a Master Reset. If the error persists, contact your Anritsu Service Center.
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Figure C-1. Self Test Results Window (Vector Network Analyzer mode)

Caution Depending upon the set mode of instrument operation, you may (or may not) see 
the full results in the Self Test list.
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Application Self Test Results Window — VNA 

Application Self Test (Vector Network Analyzer mode only)   
To run the application self test, press Shift and System (8) and then Application Self Test from 
within the desired mode. When you are in Vector Network Analyzer mode, you will see the 
results window that is shown in Figure C-2 (note that your instrument display may differ 
from this image), which summarizes the status of several key functions that are specific to 
this application. 

If the Overall Status shows Failed, then one or more elements of the Application Self Test 
have failed. This self test consists of 4 subtests:

Power Supply Test: Lists any power supply voltages that are not meeting tolerance 
specification

VCO Calibration: Lists any frequency range over which the VCO calibration is failing

Frequency Sweep: Lists any frequency range over which errors in the sweep are occurring

EEPROM: Indicates whether reading or writing (or both) to the EPPROM has failed

Figure C-2. Application Self Test Results Window (Vector Network Analyzer mode)
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If any of the subtests shows FAILED, then check that the battery level is adequate for 
operation or that temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults (Esc+On), or Master Reset (System+On). 

Application Self Test Results Window — SPA 

Caution 

Use of Master Reset (System+On), will permanently erase all user saved setups 
and measurement traces and will return the VNA Master to a full Factory Default 
condition. Be sure to make backup copies of any important files before proceeding 
with a Master Reset. If the error persists, contact your Anritsu Service Center.

Figure C-3. Application Self Test Results Window (Spectrum Analyzer mode)
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C-4 Operation Error Messages

Fan Failure
The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running. 

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument (refer to 
Figure C-4). The fan will turn on at low speed when the internal temperature of the 
instrument reaches 44ºC, and will increase the fan speed to maximum at 54ºC. As the 
internal temperature of the instrument decreases, the fan will reduce speed until the 
temperature reaches 39ºC, at which point the fan will turn off. 

High Temp Warning
The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin. The countdown gives the user a chance to 
save the current setup before the instrument turns itself off (before internal temperatures 
can cause any damage). If the error persists after removing any obstructions and allowing the 
unit to cool, then reset to the factory defaults with Factory Defaults (Esc+On), or 
Master Reset (System+On). 

Figure C-4. Fan Speed vs. Temperature

Caution 

Use of Master Reset (System+On), will permanently erase all user saved setups 
and measurement traces and will return the VNA Master to a full Factory Default 
condition. Be sure to make backup copies of any important files before proceeding 
with a Master Reset. If the error persists, contact your Anritsu Service Center.
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Operation not Permitted in Recall Mode
Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

PMON PLD Fail
Unable to communicate with the Power Monitor PCBA.

Power Supply 
Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File 
An error was detected while saving a file. Try again. 
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C-5 Vector Network Analyzer Specific Warning Messages

Bias Tee cannot be enabled for start freq < 2MHz.
Adjust frequency before turning On the Bias Tee. 

The start frequency cannot be set less than 2 MHz when the internal or external Bias Tee is 
turned On. Set the frequency to a value larger than or equal to 2 MHz, and then turn on the 
Bias Tee.

Bias Tee is not allowed for start freq < 2MHz. 
Turn Off Bias Tee before changing the freq. 

The internal or external Bias Tee cannot be turned on when the start frequency is set to less 
than 2 MHz. Turn off the Bias Tee, and then adjust the start frequency to the desired value 
less than 2 MHz.

Changing Source Power 
Changing Source Power will affect the accuracy of the current calibration.
While Cal Correction is turned On, changing the source power level will affect the accuracy of 
the current calibration. The correction will remain On and can be used, but an indicator (?P) 
will appear next to the left-hand status column (CAL: ON) to note that the current power 
setting is different from the one used during the calibration processes. 

No valid calibration to change correction.
There is no valid calibration in volatile memory that can be used to turn Cal Correction On. A 
new calibration must be performed. 

Cannot continue with calculating. 
Cannot continue with calculating. Not all required cal steps are completed. 
When performing a calibration, you must complete all of the required steps before applying 
the “Calculate and Finish Cal” step.

Bias Tee state cannot be changed during calibration. 
While performing a calibration, and before completing all of the calibration steps, you cannot 
turn on the Bias Tee. You must wait till after all of the calibration steps are complete before 
turning on the Bias Tee. This precaution is enforced to protect the calibration components 
from getting damaged by the Bias Tee current.

Turning Bias Tee to OFF. 
Bias Tee was turned on when a new calibration sequence was started. The Bias Tee was 
turned off to protect the calibration components. After all the calibration steps are completed, 
you can turn the Bias Tee back on as required.
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Turning Bias Tee to OFF. 
Turning Bias Tee to OFF. Recalling measurement does not match with current setup.
The recalled measurement file does not match the current setup. To ensure DUT safety, the 
Bias Tee function is turned off.

Turning Bias Tee to OFF. 
Turning Bias Tee to OFF. Recalling setup does not match with current setup.
The recalled setup file does not match the current setup. To ensure DUT safety, the Bias Tee 
function is turned off.

Calibration will be lost after change.   
Calibration will be lost after change. Press the button again to continue.
While performing a calibration, and before completing all the calibration steps, if you change 
any of the frequency parameters (start, stop, center, span) or the number of points, then the 
calibration must be invalidated. 

Changes not allowed during calibration. 
Changes not allowed during calibration. Press Esc to abort calibration.
Certain parameters (such as frequency and number of points) are able to be changed while 
the calibration process is underway. Changing these parameters is not allowed unless the 
calibration is aborted first.

Option 10 (Bias Tee) not enabled.
To turn on the internal or external Bias Tee, Option 10 must be enabled in the instrument. 
Contact your Anritsu Service Center to inquire about enabling this option.

No External Reference signal detected.
External Reference was switched to 10 MHz but no external 10 MHz signal was detected. The 
External Reference setting is turned back to Off. Check the external reference level and 
frequency, and then try again.

Limit is not available for this Graph type.
Limits are supported only for rectilinear graph types (not for Smith Charts, for example).
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Appendix D — Tower Mounted 
Amplifiers

D-1 Introduction    
A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are 
different types of TMA depending on the system requirements. Three commonly used types 
are:

• TMA-D - A duplex tower mounted amplifier that combines transmit and receive 
ports from the radio system and connects to a single antenna. This configuration 
is specific to systems that use a single antenna configuration.

• TMA-S - A receive-only tower mounted amplifier is installed between the 
receiving antenna and the radio to boost weak signals. This configuration is 
common on systems that implement separate antennas for transmitting and 
receiving.

• TMA-DD - A dual-duplex tower mounted amplifier used for radios systems with a 
single transmission line connection for transmit and receive. These systems are 
commonly called transceivers.

Figure D-1. Tower Mounted Amplifiers
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Appendix E — Coaxial Cable 
Technical Data

E-1 Coaxial Cable Technical Data
The table below provides a list of common coaxial cables. 

Table E-1. Coaxial Cable Technical Data  (Sheet 1 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3

Andrew FSJ1-50A (6 GHz) 0.84 1000 0.196 2500 0.313 6000 0.532
Andrew FSJ2-50 (6 GHz) 0.83 1000 0.133 2500 0.223 6000 0.374
Andrew FSJ4-50B (6 GHz) 0.81 1000 0.118 2500 0.201 6000 0.348
Andrew EFX2-50 (6 GHz) 0.85 1000 0.121 2500 0.202 6000 0.341
Andrew LDF1-50 (6 GHz) 0.86 6000 0.306 6000 0.306 6000 0.306
Andrew LDF2-50 (6 GHz) 0.88 6000 0.323 6000 0.323 6000 0.323
Andrew LDF4-50A (6 GHz) 0.88 1000 0.073 2500 0.121 6000 0.218
Andrew HJ4-50 (6 GHz) 0.914 1000 0.092 2500 0.156 6000 0.257
Andrew HJ4.5-50 (6 GHz) 0.92 1000 0.054 2500 0.089 6000 0.148
Andrew AVA5-50 7/8 0.91 1000 0.038 2000 0.055 2500 0.063
Andrew AVA7-50 1-5/8 0.92 1000 0.022 2000 0.034 2500 0.038
Andrew EFX2-50 0.85 1000 0.121 2000 0.177 2500 0.202
Andrew FLC 12-50J 0.88 1000 0.075 2000 0.11 2500 0.134
Andrew FLC 38-50J 0.88 1000 0.115 2000 0.169 2500 0.19
Andrew FLC 78-50J 0.88 1000 0.041 2000 0.061 2500 0.072
Andrew FLC 114-50J 0.88 1000 0.033 2000 0.05 2500 0.059
Andrew FLC 158-50J 0.88 1000 0.025 2000 0.038 2500 0.042
Andrew FSJ1-50A 0.84 1000 0.196 2000 0.285 2500 0.313
Andrew FSJ2-50 0.83 1000 0.133 2000 0.196 2500 0.223
Andrew FSJ4-50B 0.81 1000 0.118 2000 0.176 2500 0.201
Andrew HJ4-50 0.91 1000 0.092 2000 0.137 2500 0.156
Andrew HJ4.5-50 0.92 1000 0.054 2000 0.079 2500 0.089
Andrew HJ5-50 0.916 1000 0.042 2000 0.063 2500 0.071
Andrew HJ7-50A 0.921 1000 0.023 2000 0.034 2500 0.039
Andrew HJ12-50 0.931 1000 0.019 2000 0.029 2000 0.029
Andrew HL4RP-50A 0.88 1000 0.074 2000 0.109 2500 0.123
Andrew LDF4-50A 0.88 1000 0.073 2000 0.107 2500 0.12
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Andrew LDF4.5-50 0.89 1000 0.054 2000 0.08 2500 0.091
Andrew LDF5-50A 0.89 1000 0.041 2000 0.061 2500 0.07
Andrew LDF5-50B 0.91 1000 0.041 2000 0.061 2500 0.07
Andrew LDF6-50 0.89 1000 0.028 2000 0.042 2500 0.048
Andrew LDF7-50A 0.88 1000 0.024 2000 0.037 2500 0.043
Andrew LDF12-50 0.88 1000 0.021 2000 0.033 2000 0.033
Andrew VXL5-50 7/8 0.88 1000 0.045 2000 0.066 2500 0.075
Andrew VXL6-50 1-1/4 0.88 1000 0.032 2000 0.048 2500 0.055
Andrew VXL7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.043
Belden RG-8/8A 0.86 1000 0.132 2000 0.33 2500 0.22
Belden RG-9/9A 0.659 1000 0.289 1000 0.289 1000 0.289
Belden RG-17/17A 0.659 1000 0.18 1000 0.18 1000 0.18
Belden RG-55/55A/55B 0.659 1000 0.541 1000 0.541 1000 0.541
Belden RG-58/58B 0.77 1000 0.356 2000 0.528 2500 0.6
Belden RG-58A/58C 0.73 1000 0.594 1000 0.594 1000 0.594
Belden RG-142 0.7 1000 0.43 2000 0.663 2500 0.713
Belden RG-174 0.66 1000 1.115 1000 1.115 1000 1.115
Belden RG-178B 0.695 1000 1.509 1000 1.509 1000 1.509
Belden RG-188 0.69 1000 0.951 1000 0.951 1000 0.951
Belden RG-213 0.66 1000 0.262 1000 0.269 1000 0.269
Belden RG-214 0.659 1000 0.229 1000 0.292 1000 0.292
Belden RG-223 0.66 1000 0.476 1000 0.478 1000 0.478
Cablewave HCC 12-50J 0.915 1000 0.087 2000 0.126 2500 0.137
Cablewave HCC 78-50J 0.915 1000 0.041 2000 0.061 2500 0.066
Cablewave HCC 158-50J 0.95 1000 0.022 2000 0.031 2500 0.033
Cablewave HCC 300-50J 0.96 1000 0.015 1000 0.015 1000 0.015
Cablewave HCC 312-50J 0.96 1000 0.013 1000 0.013 1000 0.013
Cablewave HF 4 1/8 Cu2Y 0.97 1000 0.01 1000 0.01 1000 0.01
Cablewave HF 5 Cu2Y 0.96 1000 0.007 1000 0.007 1000 0.007
Cablewave HF 6 1/8 Cu2Y 0.97 1000 0.006 1000 0.006 1000 0.006
Cellflex LCF78-50JA 0.9 1000 0.039 2000 0.058 2500 0.066
Cellflex LCFS114-50JA 0.9 1000 0.029 2000 0.044 2500 0.051
Cellflex LCF158-50JA 0.9 1000 0.024 2000 0.036 2500 0.042
Cellflex LCF214-50JA 0.88 1000 0.021 2000 0.033 2000 0.033
Cellflex UCF114-50JA 0.89 1000 0.031 2000 0.047 2000 0.047

Table E-1. Coaxial Cable Technical Data  (Sheet 2 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Comscope CR50 540PE 0.88 1000 0.069 2000 0.103 2500 0.116
Comscope CR50 1070PE 0.88 1000 0.037 2000 0.055 2500 0.064
Comscope CR50 1873PE 0.88 1000 0.022 2000 0.034 2500 0.04
Eupen EC4-50-HF 1/2 0.82 1000 0.108 2000 0.161 2500 0.183
Eupen EC4-50 1/2 0.88 1000 0.074 2000 0.109 2500 0.121
Eupen EC4.5-50 5/8 0.88 1000 0.056 2000 0.083 2500 0.094
Eupen EC5-50 7/8 0.88 1000 0.04 2000 0.058 2500 0.066
Eupen EC6-50 1-1/4 0.88 1000 0.028 2000 0.043 2500 0.048
Eupen EC7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.042
Eupen EC7-50A 1-5/8 0.89 1000 0.023 2000 0.035 2500 0.039
Eupen EC12-50 2-1/4 0.88 1000 0.022 2000 0.034 2500 0.039
Nk Cables RF1/2-50 0.88 1000 0.073 2000 0.107 2500 0.127
Nk Cables RF1/2-50GHF 0.88 1000 0.073 2000 0.107 2500 0.127
Nk Cables RF1/2-50BHF 0.88 1000 0.073 2000 0.107 2500 0.127
Nk Cables RF5/8-50 0.88 1000 0.051 2000 0.075 2500 0.087
Nk Cables RF5/8-50GHF 0.88 1000 0.051 2000 0.075 2500 0.087
Nk Cables RF5/8-50BHF 0.88 1000 0.051 2000 0.075 2500 0.087
Nk Cables RF7/8-50 0.88 1000 0.04 2000 0.059 2500 0.07
Nk Cables RF7/8-50GHF 0.88 1000 0.04 2000 0.059 2500 0.07
Nk Cables RF7/8-50BHF 0.88 1000 0.04 2000 0.059 2500 0.07
Nk Cables RF1 5/8-50 0.88 1000 0.024 2000 0.036 2500 0.042
Nk Cables RF1 5/8-50GHF 0.88 1000 0.024 2000 0.036 2500 0.042
Nk Cables RF1 5/8-50BHF 0.88 1000 0.024 2000 0.036 2500 0.042
Nk Cables RF2 1/4-50 0.88 1000 0.021 2000 0.032 2500 0.041
Nk Cables RF2 1/4-50GHF 0.88 1000 0.021 2000 0.032 2500 0.041
Nk Cables RF2 1/4-50BHF 0.88 1000 0.021 2000 0.032 2500 0.041
Nk Cables RFF3/8-50 0.81 1000 0.147 2000 0.218 2500 0.25
Nk Cables RFF3/8-50GHF 0.81 1000 0.147 2000 0.218 2500 0.25
Nk Cables RFF3/8-50BHF 0.81 1000 0.147 2000 0.218 2500 0.25
Nk Cables RFF1/2-50 0.82 1000 0.112 2000 0.167 2500 0.19
Nk Cables RFF1/2-50GHF 0.82 1000 0.112 2000 0.167 2500 0.19
Nk Cables RFF1/2-50BHF 0.82 1000 0.112 2000 0.167 2500 0.19
Nk Cables RFF7/8-50 0.88 1000 0.04 2000 0.066 2500 0.076
Nk Cables RFF7/8-50GHF 0.88 1000 0.04 2000 0.066 2500 0.076
Nk Cables RFF7/8-50BHF 0.88 1000 0.04 2000 0.066 2500 0.076

Table E-1. Coaxial Cable Technical Data  (Sheet 3 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Times LMR100 0.66 1000 0.789 2000 1.15 2500 1.31
Times LMR200 0.83 1000 0.342 2000 0.49 2500 0.554
Times LMR240 0.84 1000 0.261 2000 0.377 2500 0.424
Times LMR400 0.85 1000 0.135 2000 0.196 2500 0.222
Times LMR500 0.86 1000 0.109 2000 0.159 2500 0.18
Times LMR600 0.87 1000 0.087 2000 0.128 2500 0.145
Times LMR900 0.87 1000 0.059 2000 0.086 2500 0.098
Times LMR1200 0.88 1000 0.044 2000 0.065 2500 0.074
Times LMR1700 0.89 1000 0.033 2000 0.049 2500 0.057
 310801 0.821 1000 0.115 1000 0.115 1000 0.115
 311201 0.82 1000 0.18 1000 0.18 1000 0.18
 311501 0.8 1000 0.23 1000 0.23 1000 0.23
 311601 0.8 1000 0.262 1000 0.262 1000 0.262
 311901 0.8 1000 0.377 1000 0.377 1000 0.377
 352001 0.8 1000 0.377 1000 0.377 1000 0.377

Table E-1. Coaxial Cable Technical Data  (Sheet 4 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Appendix F — Waveguide Data

F-1 Introduction
This appendix provides lists of waveguide components and their characteristics.

F-2 Calibration Components
The calibration components part numbers in the following table are broken down as follows, 
where the xx in the part number column (as in xxUM70) is replaced as follows:

xx:    23 = 1/8 Offset Short

24 = 3/8 Offset Short

26 = Precision Load

Table F-1. Precision Waveguide Calibration Components 

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges

xxUM70 5.85 to 8.20 WR137, WG14 CAR70, PAR70, UAR 70, PDR70
xxUM84 7.05 to 10.00 WR112, WG15 CBR84, UBR84, PBR84, PDR84
xxUM100 8.20 to 12.40 WR90, WG16 CBR100, UBR100, PBR100, 

PDR100
xxUM120 10.00 to 15.00 WR75, WG17 CBR120, UBR120, PBR120, 

PDR120
xxUA187 3.95 to 5.85 WR187, WG12 CPR187F, CPR187G, 

UG-1352/U, UG-1353/U, 
UG-1728/U, UG-1729/U, 
UG-148/U, UG-149A/U

xxUA137 5.85 to 8.20 WR137, WG14 CPR137F, CPR137G, 
UG-1356/U, UG-1357/U, 
UG-1732/U, UG-1733/U, 
UG-343B/U, UG-344/U, 
UG-440B/U, UG-441/U

xxUA112 7.05 to 10.00 WR112, WG15 CPR112F, CPR112G, UG-1358/U, 
UG-1359/U, UG-1734/U, 
UG-1735/U, UG-52B/U, UG-51/U, 
UG-137B/U, UG-138/U

xxUA90 8.20 to 12.40 WR90, WG16 CPR90F, CPR90G, 
UG-1360/U, UG-1361/U, 
UG-1736/U, UG-1737/U, 
UG-40B/U, UG-39/U, 
UG-135/U, UG-136B/U
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F-3 Waveguide-to-Coaxial Adapters
Part numbers that end with N have Type N connectors, part numbers that end with K have 
K Connectors. 

xxUA62 12.40 to 18.00 WR62, WG18 UG-541A/U, UG-419/U, 
UG-1665/U, UG1666/U

xxUA42 17.00 to 26.50 WR42, WG20 UG-596A/U, UG-595/U, 
UG-597/U, UG-598A/U

Table F-2. Coaxial to Universal Waveguide Adapters 

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges

35UM70N 5.85 to 8.20 WR137, WG14 CAR70, PAR70, UAR 70, 
PDR70

35UM84N 7.05 to 10.00 WR112, WG15 CBR84, UBR84, PBR84, PDR84
35UM100N 8.20 to 12.40 WR90, WG16 CBR100, UBR100, PBR100, 

PDR100
35UM120N 10.00 to 15.00 WR75, WG17 CBR120, UBR120, PBR120, 

PDR120
35UA187N 3.95 to 5.85 WR187, WG12 CPR187F, CPR187G, 

UG-1352/U, UG-1353/U, 
UG-1728/U, UG-1729/U, 
UG-148/U, UG-149A/U

35UA137N 5.85 to 8.20 WR137, WG14 CPR137F, CPR137G, 
UG-1356/U, UG-1357/U, 
UG-1732/U, UG-1733/U, 
UG-343B/U, UG-344/U, 
UG-440B/U, UG-441/U

35UA112N 7.05 to 10.00 WR112, WG15 CPR112F, CPR112G, 
UG-1358/U, UG-1359/U, 
UG-1734/U, UG-1735/U, 
UG-52B/U, UG-51/U, 
UG-137B/U, UG-138/U

35UA90N 8.20 to 12.40 WR90, WG16 CPR90F, CPR90G, 
UG-1360/U, UG-1361/U, 
UG-1736/U, UG-1737/U, 
UG-40B/U, UG-39/U, 
UG-135/U, UG-136B/U

35UA62N 12.40 to 18.00 WR62, WG18 UG-541A/U, UG-419/U, 
UG-1665/U, UG1666/U

35UA42K 7.00 to 26.50 WR42, WG20 UG-596A/U, UG-595/U, 
UG-597/U, UG-598A/U

Table F-1. Precision Waveguide Calibration Components  (Continued)

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges
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F-4 Flange Compatibility 
Table F-3. Universal Flange Compatibility (1 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges

xxUM40 3.300 4.900 WR229 
WG11A

UnivM-229 PDR40

xxUM48 3.950 5.850 WR187 
WG12

UnivM-187 CAR48 
PAR48 
UAR48 
PDR48

xxUM58 4.900 7.050 WR159 
WG13

UnivM-159 CAR58 
PAR58 
UAR58 
PDR58

xxUM70 5.850 8.200 WR137 
WG14

UnivM-137 CAR70 
PAR70 
UAR70 
PDR70

xxUM84 7.050 10.000 WR112 WG15 UnivM-112 CBR84 
UBR84 
PBR84 
PDR84

xxUM100 8.200 12.400 WR90 WG16 UnivM-90 CBR100 
UBR100 
PBR100 
PDR100

xxUM120 10.000 15.000 WR75 WG17 UnivM-75 CBR120 
UBR120 
PBR120 
PDR120

xxUM140 12.400 18.000 WR62 WG18 UnivM-62 CBR140 
UBR140 
PBR140 
PDR140

xxUM220 17.000 26.500 WR42 WG20 UnivM-42 CBR220 
UBR220 
PBR220 
PDR220

xxUA229 3.300 4.900 WR229 
WG11A

UnivUS-229 CPR229F 
CPR229G 
UG-1350/U 
UG-1351/U 
UG-1726/U 
UG-1727/U
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Universal Flange Compatibility 

Table F-4. Universal Flange Compatibility (2 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges

xxUA187 3.950 5.850 WR187 
WG12

UnivUS-187 CPR187F 
CPR187G 
UG-1352/U 
UG-1353/U 
UG-1728/U 
UG-1729/U 
UG-148/U 
UG-149A/U

xxUA159 4.900 7.050 WR159 
WG13

UnivUS-159 CPR159F 
CPR159G 
UG-1354/U 
UG-1355/U 
UG-1730/U 
UG-1731/U

xxUA137 5.850 8.200 WR137 
WG14

UnivUS-137 CPR137F 
CPR137G 
UG-1356/U 
UG-1357/U 
UG-1732/U 
UG-1733/U 
UG-343B/U 
UG-344/U 
UG-440B/U 
UG-441/U

xxUA112 7.050 10.00 WR112 WG15 UnivUS-112 CPR112F 
CPR112G 
UG-1358/U 
UG-1359/U 
UG-1734/U 
UG-1735/U 
UG-52B/U 
UG-51/U 
UG-137B/U 
UG-138/U
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xxUA90 8.200 12.400 WR90 WG16 UnivUS-90 CPR90F 
CPR90G 
UG-1360/U 
UG-1361/U 
UG-1736/U 
UG-1737/U 
UG-40B/U 
UG-39/U 
UG-135/U 
UG-136B/U

xxUA75 10.000 15.000 WR75 WG17 UnivUS-75 WR75

Table F-4. Universal Flange Compatibility (2 of 3)  (Continued)

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges
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Universal Flange Compatibility 

Table F-5. Universal Flange Compatibility (3 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type Flange Type
Compatible 

Flanges

xxUA62 12.400 18.000 WR62
WG18

UnivUS-62 UG-541A/U 
UG-419/U 
UG-1665/U 
UG-1666/U

xxUA42 17.000 26.500 WR42
WG20

UnivUS-42 UG-596A/U 
UG-595/U 
UG-597/U 
UG-598A/U

xxCMR229 3.300 4.900 WR229 
WG11A

CMR229 CMR229

xxCMR187 3.950 5.850 WR187 
WG12

CMR187 CMR187 
UG-1475/U 
UG-1480/U

xxCMR159 4.900 7.050 WR159 
WG13

CMR159 CMR159

xxCMR137 5.850 8.200 WR137 
WG14

CMR137 CMR137 
UG-1476/U 
UG-1481/U

xxCMR112 7.050 10.000 WR112 
WG15

CMR112 CMR112 
UG-1477/U 
UG-1482/U

xxCMR90 8.200 12.400 WR90
WG16

CMR90 CMR90 
UG-1478/U 
UG-1483/U

xxUER40 3.300 4.900 WR229 
WG11A

UER40 UER40

xxUER48 3.950 5.850 WR187 
WG12

UER48 UER48

xxUER58 4.900 7.050 WR159 
WG13

UER58 UER58

xxUER70 5.850 8.200 WR137 
WG14

UER70 UER70

xxUER84 7.050 10.000 WR112 
WG15

UER84 UER84

xxUER100 8.200 12.400 WR90
WG16

UER100 UER100
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F-5 Waveguide Technical Data 
Table F-6. Waveguide Offset Shorta Specifications 

a.Offset shorts are 3/8 wave at the geometric mean frequency waveguide band and dimensionally accurate 
to <0.5 degree at the maximum operating frequency of the corresponding wavelength.

Offset Short P/N Frequency (GHz) Length (mm)

24UM70 6.926 20,710 +/- 0.08
24UM84 8.396 17,040 +/- 0.05
24UM100 10.084 14,675 +/- 0.05
24UM120 12.247 11,978 +/- 0.04
24UA187 4.807 30,979 +/- 0.11
24UA137 6.926 20,710 +/- 0.08
24UA112 8.396 17,040 +/- 0.05
24UA90 10.084 14,675 +/- 0.05
24UA62 14.940 9,742 +/- 0.04
24UA42 21.225 7,067 +/- 0.03
24CMR187 4.807 30,979 +/- 0.11
24CMR137 6.926 20,710 +/- 0.08
24CMR112 8.396 17,040 +/- 0.05
24CMR90 10.084 14,675 +/- 0.05
24UER70 6.926 20,710 +/- 0.08
24UER84 8.396 17,040 +/- 0.05
24UER100 10.084 14,675 +/- 0.05

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



F-5 Waveguide Technical Data Waveguide Data

F-8 PN: 10580-00305  Rev. N MS20xxC UG

Waveguide Technical Data 

Table F-7. Waveguide Technical Data (Sheet 1 of 2)

Waveguide 
Type/Model

Start Frequency 
(GHz)

Stop Frequency 
(GHz)

Cutoff 
Frequency 

(GHz)
Mid-Band Loss 

(dB/m)

WR229, WG11A 3.300 4.900 2.577 0.0374
WR187, WG12 3.950 5.850 3.152 0.0515
WR159, WG13 4.900 7.050 3.711 0.0591
WR137, WG14 5.850 8.200 4.301 0.0738
WR112, WG15 7.050 10.000 5.259 0.1024
WR102 7.000 11.000 5.786 0.1083
WR90, WG16 8.200 12.400 6.557 0.1578
WR75, WG17 10.000 15.000 7.868 0.1913
WR67 11.000 17.000 8.578 0.2159
WR62, WG18 12.400 18.000 9.486 0.2411
WR51, WG19 15.000 22.000 11.574 0.3691
WR42, WG20 17.000 26.500 14.047 0.5200

Andrew

EW17 1.700 2.400 1.364 0.012
EW20 1.900 2.700 1.57 0.015
EW28 2.600 3.400 2.2 0.021
EW34 3.100 4.200 2.376 0.0223
EW37 3.300 4.300 2.790 0.0292
EW43 4.400 5.000 2.780 0.0289
EW52 4.600 6.425 3.650 0.042
EW63 5.580 7.125 4.000 0.0453
EW64 5.300 7.750 4.320 0.052
EW77 6.100 8.500 4.720 0.061
EW85 7.700 9.800 6.460 0.1086
EW90 8.300 11.700 6.500 0.108
EW127 10.000 13.250 7.670 0.124
EW132 11.000 15.350 9.220 0.17
EW180 14.000 19.700 11.150 0.1939
EW220 17.000 23.600 13.340 0.2822
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Cablewave

WE37 3.600 4.200 2.830 0.0269
WE46 4.400 5.000 3.000 0.0354
WE61 5.925 6.425 3.600 0.0390
WE65 6.425 7.125 4.000 0.0453
WE70 7.125 7.750 4.300 0.0404
WE78 7.125 8.500 4.670 0.0446
WE108 10.500 11.700 6.570 0.0978
WE130 11.700 13.250 7.430 0.1142
WE150 14.000 15.350 8.600 0.1398
WE191 17.700 19.700 10.680 0.1952

RFS Cablewave

E20 1.700 2.300 1.38 0.012
E30 2.300 3.100 1.8 0.016
E38 3.000 4.200 2.4 0.025
E46 3.650 5.000 2.88 0.028
ES46 3.900 5.000 3.08 0.036
E60 4.500 6.425 3.65 0.045
E65 5.000 7.125 4.01 0.05
E78 5.900 8.500 4.72 0.06
E105 8.100 11.700 6.49 0.09
E130 9.300 13.250 7.43 0.12
E150 10.800 15.350 8.64 0.15
E185 13.700 19.700 11.06 0.2
E220 16.700 23.600 13.36 0.29

Table F-7. Waveguide Technical Data (Sheet 2 of 2)

Waveguide 
Type/Model

Start Frequency 
(GHz)

Stop Frequency 
(GHz)

Cutoff 
Frequency 

(GHz)
Mid-Band Loss 

(dB/m)
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Appendix G — More About DHCP

G-1 Introduction
DHCP stands for Dynamic Host Configuration Protocol. This protocol allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses. When a DHCP server is available on the 
network, DHCP is the preferred IP address mode.

G-2 Ethernet Configuration

LAN Connection 
The RJ-45 connector is used to connect the VNA Master to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. The instrument IP address is set by pressing the Shift key, 
then the System (8) key followed by the System Options submenu key and the Ethernet Config 
submenu key. The instrument Ethernet address can be set automatically using DHCP, or 
manually by entering the desired IP address, gateway address, and subnet mask. 

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is the most common method 
of configuring a device for network use. To determine if a network is set up for DHCP, connect 
the MS20xxC to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the VNA Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power up sequence.

Note

An active Ethernet cable must be connected to the instrument before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address.
Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options submenu key and the Ethernet Config submenu key. The IP 
address will be displayed as shown in Figure G-1. The image on the display panel of your 
VNA Master may differ from the image shown here. 

Figure G-1. IP Address Assigned Using DHCP
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Ethernet Config 
Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor 
dialog box in order to set the IP address of the instrument. 

Figure G-2. Setting IP Address Manually
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Ethernet Menu  
Key Sequence: Shift, System (8) > System Options > Ethernet Config 

G-3 Using DHCP
When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the assigned IP address may change from use to use. The DHCP server assigns 
IP addresses on a time rotation basis. As soon as the device is disconnected from the network, 
the IP address that it was using becomes available to lease to the next unit requesting an IP 
address. Normally, some amount of lag time occurs on the DHCP server end, so if the device 
is connected again reasonably soon, it may receive the same address.

G-4 Static IP Address
When a DHCP server is not available, a Static IP address can be used. A Static IP address is 
a fixed address. After being set, it will always remain the same, and care must be taken to 
avoid conflict with other equipment on the network.

Type
Manual DHCP: Press this submenu key to select whether the address will 
be entered manually, or will be supplied automatically by a network DHCP 
server. If Manual is selected, then use the submenu keys or the Left/Right 
arrow keys to select the field that is to be modified. Use the keypad, the 
Up/Down arrow keys, or the rotary knob to enter the input. Press Enter to 
accept the changes, or press the Esc key to return to normal operation 
without changing anything.
Field
IP G-Way Sub: Press this submenu key to select the desired Internet 
Protocol Property to be edited.
First Octet: Moves the cursor to the left most column of the selected IP 
properties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.
Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.
Fourth Octet: Moves the cursor to the fourth column from the left of the 
selected IP properties field.

Figure G-3. Ethernet Menu

Note
The VNA Master must be connected to the network before it is turned on in order 
to allow DHCP to work. Key elements of the DHCP lease are performed only 
during the instrument startup operations or when switching from manual to DHCP.

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fourth Octet
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When using a static IP address on an established network, always request a Static IP address 
from the network administrator. Randomly choosing a Static IP address on an established 
network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a Static IP address:

IP Address
This is the Static IP address on the network.

Default Gateway
Often when a static IP address is assigned, a default gateway is also identified. If the default 
gateway is unknown, then type in the Static IP address so that the Static IP address and 
Default Gateway are the same number.

Subnet Mask
This parameter is usually extracted from the Static IP address based upon the class of the 
address. It determines the destination of any broadcast messages that might be sent from the 
instrument. It can be customized if necessary. The subnet mask may also be provided with 
the Static IP address.

Example 1
In this example, a Static IP address has been chosen because no network is available. The 
instrument is connected to the network port on the PC with a crossover Ethernet cable (not 
included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2
Default Gateway: 10.0.0.2
Subnet Mask: 255.255.0.0

Example 2
In this example, the Static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42
Default Gateway: 153.56.100.1
Subnet Mask: 255.255.252.0

G-5 Operating System Tools
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network that the PC is plugged into. 
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Ipconfig Tool
Typing ipconfig at a command prompt will display information about the in-use parameters of 
the PC and its network connection. Below is an example of the typical results expected. 

Y:\>ipconfig
Windows IP Configuration
Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix  . : us.anritsu.com
Link-Local IPv6 Address   . . . . : fe80::2980::797d::3383::360d%11
IPv4 Address  . . . . . . . . . . : 172.26.202.162
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1

Ping Tool
Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network and, if it is found, for it 
to reply. Greatly simplified, ping sends out a request to a specific address to determine if it is 
there. If the specific address is found, then it will respond by sending back the same message 
that was received. If it is not found, then the response will be “request timed out.” This means 
that no reply was received from that IP address.

Y:\>ping 172.26.202.172
Pinging 172.26.202.172 with 32 bytes of data:
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Ping statistics for 172.26.202.172:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms

Note The ipconfig display does not report if the information is from a DHCP server or a 
Static IP setup
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Appendix H — Glossary of Terms
Introduction
The following terms are related to this product and technology.

Glossary Terms
3 dB rule : The 3 dB rule provides a means to estimate relative power values. A 3 

dB gain indicates that power increases to twice the power (a multiple of 
2). A 3 dB loss indicates that power decreases to half the power (a 
multiple of 1/2). A system with 40 watts of input power and a 6 dB 
insertion loss will have only 10†watts of output power (a multiple of 1/2 
for each 3 dB loss, or 1/4 of 40 watts). 

 

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

 

Adaptive Array
Antenna : Adaptive array antenna is a type of advanced ’smart’ antenna 

technology that continually monitors a received signal and dynamically 
adapts signal patterns to optimize wireless system performance. The 
arrays use signal processing algorithms to adapt to user movement, to 
changes in the radio-frequency environment, and to multi-path and 
co-channel interference. 

 

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device 
that converts continuous signals to discrete digital numbers. The 
reverse operation is performed by a digital-to-analog converter (DAC). 
ADC can uniquely represent all analog input values within a specified 
total input range by a limited number of digital output codes. Refer also 
to DAC. 

 

Analog System : An Analog system uses an analog transmission method to send voice, 
video and data-using analog signals, such as electricity or sound waves, 
that are continuously variable rather than discreet units as in digital 
transmissions. Mobile analog systems include AMPS, NMT and 
ETACS. 

 

Analog
Transmission : Analog Transmission refers to signals propagated through the medium 

as continuously varying electromagnetic waves. 

 

Antenna : Antenna is a device which radiates and/or receives radio signals, 
including RF, microwave, and RADAR. 
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Antenna
beamwidth : Antenna beamwidth, also known as the half-power beamwidth, is the 

angle of an antenna pattern or beam over which the relative power is at 
or above 50% of the peak power. 

 

Antenna Directivity : Antenna directivity, also known as antenna gain, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Directivity is the percentage of 
radiated signal transmitted or received in a given direction related to 
beamwidth. 

 

Antenna Efficiency : Antenna Efficiency is the percentage of theoretical gain actually 
realized from an antenna. 

 

Antenna Gain : Antenna gain, also known as antenna directivity, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Gain is the effectiveness of a 
directional antenna expressed as the ratio of input power of the 
directional antenna to input power of an isotropic radiator to provide 
the same field strength in the desired direction. Sometimes related to a 
dipole antenna. 

 

Antenna, Isotropic : An isotropic antenna is a theoretical point source radiating a spherical 
power envelope. 

 

Antenna, Parabolic : A parabolic antenna is an antenna utilizing a reflector that is shaped as 
a paraboloid in order to both concentrate the radiated signal into a 
beam and to provide considerable gain. Beamwidth varies inversely and 
gain varies directly with the size of the antenna and with frequency. 

 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 

 

Average power : Average power is the peak power averaged over time and is usually 
applied to pulsed systems where the carrier power is switched on and 
off. 
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Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

 

Bandwidth : Bandwidth usually identifies the capacity of a circuit or amount of data 
that can be sent through a given circuit. It may be user-specified in a 
PVC. It is an indication of the amount of data that is passing over a 
medium. Also, bandwidth is the portion of the frequency spectrum 
required to transmit desired information. Each radio channel has a 
center frequency and additional frequencies above and below this 
carrier frequency which is used to carry the transmitted information. 
The range of frequencies from the lowest to the highest used is called 
the bandwidth. 

 

BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) is a measure of transmission quality. The ratio of error bits to the 
total number of bits transmitted. A bit error rate of 10-6 refers to an 
average of one error per million bits. It is generally shown as a negative 
exponent, (for example, 10-7 which means 1 out of 107 bits are in error 
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of 
a sequence of message bits that are in error. 

 

BERT : Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of 
the T1 or digital line. By sending a known pattern to another device 
across the span, the far end device can compare incoming pattern to its 
own, thereby indicating bit errors on the line. 

 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 
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Calibration : When making measurements, the instrument must be calibrated in 
order to remove residual errors due to measurement setup conditions. 
Anritsu recommends performing the calibration under the same 
conditions as the measurement: temperature, frequency, number of 
points, source power, and IFBW. Calibrations standards with known 
reflection coefficients are used to calculate the correction factors. The 
calibration must be conducted using the appropriate standards at the 
open end of any test port cables and adapters that are connected to the 
instrument. This ensures that the match, phase length, and loss of 
these cables and adapters are all accounted for. For optimal 
performance, high quality phase-stable cables and precision adapters 
must be used. 

 

Cell Site : Cell Site, also called Base Station, is the local cellular tower and radio 
antenna (including the radios, controller, switch interconnect, etc.) that 
handles communication with subscribers in a particular area or cell. A 
cellular network is made up of many cell sites, all connected back to the 
switch via landline or microwave. 

 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

 

CW : Continuous Wave (CW) 

 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 
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dB : Decibel or deciBel (dB) is a logarithmic ratio of the difference between 
two values (a logarithm ratio is equal to 10 times). dB is a unit for 
measuring relative power ratios in terms of gain or loss. The units of dB 
are expressed in terms of the logarithm to base 10 of a ratio and 
typically are expressed in watts. For example, a -3 dB loss indicates a 
50% loss in power; a +3 dB reading is a doubling of power; 10 dB 
indicates an increase (or a loss) by a factor of 10; 20 dB indicates an 
increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a 
loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB 
= 1:1, 10 dB = 10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or 
(1/1000):1]. 

 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. Typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

 

dBm : dBm is an absolute measurement of power relative to 1 milliwatt. In 
other words, dBm is a decibel value referenced to a milliWatt (dBm). 
This is a technique for expressing a power measurement in logarithmic 
form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts 
(W) to one milliwatt (1mW). dBm, therefore, represents absolute power. 
Examples are: 0 dBm = 1.0 milliwatt, 10 dBm = 10 milliwatt, 30 dBm = 
1000 milliwatt = 1 watt. 

 

DHCP : Dynamic Host Configuration Protocol (DHCP) 

 

DSP : Digital Signal Processing (DSP) 

 

DTF : Distance-To-Fault (DTF) is the distance from the instrument output 
connector (or the end of a test lead) to a problem area, as indicated by a 
peak in the displayed signal. DTF measures the location and reflection 
size of impedance mismatches. This is typically a diagnostic 
measurement, not a pass/fail judgement measurement. DTF is used to 
identify and locate faults within an antenna system when the system is 
failing to meet the specified return loss or VSWR limits. DTF is also 
useful to verify the total length of a coaxial cable assembly. 

 

FFT : Fast Fourier Transform (FFT) is an efficient algorithm to compute the 
Discrete Fourier transform (DFT) and its inverse. FFTs are of great 
importance to a wide variety of applications, from digital signal 
processing to solving partial differential equations to algorithms for 
quickly multiplying large integers. 
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Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. It is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. It is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

 

GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 meters to 100 meters. 
The satellites use simple mathematical calculations to broadcast 
information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

 

Impedance : Impedance is a measure of RF component electrical resistance, 
measured in ohms. In most cable and antenna systems, the standard 
impedance is 50 ohms. 

 

Insertion Loss : Insertion Loss (or Cable Loss) is a measure of the total amount of signal 
energy absorbed (lost) by the cable assembly. It is measured in dB. S21 
(an S-Parameter) is another name for this measurement. 

 

IP Address : An Internet Protocol address (IP address) is usually a numerical label 
that is assigned to each device (computer or printer for example) that is 
participating in a computer network that uses the Internet Protocol for 
communication. An IP address serves two main functions: location 
addressing and host (or network) interface identification. The Internet 
Protocol originally defined an IP address as a 32-bit number. This was 
known as Internet Protocol Version 4 (IPv4), which is still in use. 
Growth of the Internet requires a new addressing system. An Internet 
Protocol Version 6 (IPv6) that uses 128 bits for the address was 
developed in 1995, and it is standardized as RFC 2460. IPv6 began 
being deployed worldwide in the year 2000. IP adresses are binary 
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numbers, but they are usually stored in text files and displayed in 
human-readable notations, such as decimal nnn.nnn.nnn.nnn or 
172.16.255.1 (for IPv4), and hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal 
group (nnn) represents values from 000 to 255, or binary values of 8 
bits. In IPv6, each hexadecimal group (nnnn) represents values from 
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 
1111 1111 1111). 

 

IPv6 : Internet Protocol Version 6 (IPv6) is a numerical label that is used to 
identify a network interface of a computer or other network node 
participating in an IPV6-enabled computer network. IPv6 uses 128 bits 
for the address (as compared to an IPv4 address, which is defined as a 
32-bit number). Pv6 was developed in 1995, and it is standardized as 
RFC 2460. V6 began being deployed worldwide in the year 2000. I 
addresses are binary numbers, but they are usually stored in text files 
and displayed in human-readable notations, such as hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). 
Ea hexadecimal group (nnnn) represents values from 0000 to†FFFF, or 
binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111). 

 

LST : Line Sweep tools (LST) is PC-based post-processing software that 
efficiently manipulates line sweep and PIM traces for reporting 
purposes. 

 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. F (the noise figure) is defined 
as the decibel value of the noise factor. NF = 10log (F) where log uses 
the base 10, or common log. This formula is valid only then the input 
termination is at standard noise temperature. 

 

OBW : Occupied Bandwidth (OBW) is a measure of the bandwidth containing 
99% of the total integrated power of the transmitted spectrum, centered 
on the assigned channel frequency. Interference to other channels or to 
other systems can occur if OBW is too large. 

 

OSL : OSL or Open Short Load calibration method for coaxial line types. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
SSL or Offset Short 1, Offset Short 2, Load calibration method for 
waveguide line types. 
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OSLT : OSLT or Open Short Load Thru calibration method for coaxial line 
types. Calibrations standards with known reflection coefficients are 
used to calculate the correction factors. Refer to Calibration. Compare 
this with SSLT or Offset Short 1, Offset Short 2, Load, Thru calibration 
method for waveguide line types. 

 

OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 

 

Return Loss : Return Loss is a measurement (in dB) of reflected energy caused by 
impedance mismatch. May also be referred to as S11. Although S11 
values are expressed as negative numbers, Return Loss values are 
expressed as positive numbers because by definition the ìLossî 
expression implies a negative sign. The higher the value, the better the 
impedance match (think of a large negative number being less than a 
smaller negative number). 40 dB is nearly ideal. Only 0.01 % of the total 
transmitted power is reflected if the Return Loss measurement value is 
40 dB. A measured value of 0 dB would be a complete reflection, or 
stated another way, 100 % of the transmitted power is reflected back. 
Return Loss is typically a pass/fail measurement. 

 

RF : Radio Frequency (RF) is the frequency of radio sine waves. RF generally 
refers to wireless communications within a frequency range of 3 kHz to 
300 GHz. Formally, according to the Article 2 of the Radio Law, radio 
frequency is below 3,000 GHz. Radio frequencies can be used for 
communications between a mobile telephone and an antenna mast. 

 

SCPI : Standard Commands for Programmable Instruments (SCPI) 

 

SOLT : SOLT or Short Open Load Thru calibration method for coaxial line 
types with simple and redundant standards. It is not band-limited. It 
requires well-defined standards. It has lower accuracy at higher 
frequencies. Calibrations standards with known reflection coefficients 
are used to calculate the correction factors. Refer to Calibration. 
Compare this with SSLT or Offset Short 1, Offset Short 2, Load, Thru 
calibration method for waveguide line types. 
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SSL : SSL or Short Short Load or Offset Short 1, Offset Short 2, Load 
calibration method for waveguide line types uses Shorts with different 
offset lengths. It is a calibration (common in waveguide) with simple 
and redundant standards, but it is band-limited. It requires 
well-defined standards. It has lower accuracy at higher frequencies. 
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
OSL or Open Short Load calibration method for coaxial line types. 

 

SSLT : SSLT or Short Short Line Thru or Offset Short 1, Offset Short 2, Load, 
Thru calibration method for waveguide line types uses Shorts with 
different offset lengths. It is a calibration (common in waveguide) with 
simple and redundant standards, but it is band-limited. It requires 
well-defined standards. It has lower accuracy at higher frequencies. 
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
OSLT or Open Short Load Thru calibration method for coaxial line 
types. 

 

VSWR : Voltage Standing Wave Ratio (VSWR). VSWR is another method to 
measure reflected energy caused by impedance mismatch. It is 
expressed as a ratio of X:1. VSWR measures the voltage peaks and 
valleys. A ratio of 1:1 would be a perfect match. A typical cable and 
antenna system would be around 1.43:1 (VSWR) or 15 dB Return Loss. 

 

Watt : Watt (W) is a unit of measure for power. 

 

:
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A

activating GPS  . . . . . . . . . . . . . . . . . . . 7-1
adapter

AC-DC . . . . . . . . . . . . . . . . . . . . . . . 1-9
address, Ethernet IP address . . . . . . . . G-1
amplifier, tower mounted . . . . . . . . . . . D-1
analyzer options, documents  . . . . . . . . A-1
Anritsu

contacting . . . . . . . . . . . . . . . . . . . . 1-2
Tool Box  . . . . . . . . . . . . . . . . . .8-1, 8-2

antenna
connector location for GPS . .2-20, 2-21
connector, SMA GPS  . . . . . . . . . . 2-28
ESD cautions  . . . . . . . . . . . . . . . . 1-10
GPS . . . . . . . . . . . . . . . . . . . . . . . . . 7-1
GPS antenna location  . . . . . . . . . . 7-2

application
self test  . . . . . . . . . . . . . . . . . . . . . 6-14

application options
menu, SPA  . . . . . . . . . . . . . . . . . . . 6-7
menu, VNA . . . . . . . . . . . . . . . . . . . 6-5
SPA system settings . . . . . . . . . . . 2-32
VNA system settings  . . . . . . . . . . 2-32

application self test submenu key . . . . 6-4
application self test, VNA  . . . . . . . . . . C-4
attenuation

high input power  . . . . . . . . . . . . . . 3-1
attenuation of power monitor  . . . . . . . 3-1
auto dim

brightness submenu key  . . . . . . . 6-10
delay setting submenu key  . . . . . 6-10
on/off submenu key  . . . . . . . . . . . 6-10

B
battery

charging  . . . . . . . . . . . . . . . . .1-9, 2-25
door (image)  . . . . . . . . . . . . . . . . . . 1-9
replacement  . . . . . . . . . . . . . . . . . . 1-9
symbol . . . . . . . . . . . . . . . . . . . . . . 2-29

bias
Bias Input Port 1, BNC . . . . . . . . 2-26
Bias Input Port 2, BNC . . . . . . . . 2-26
Bias Tee error messages  . . . . . . . . C-8
Status LED . . . . . . . . . . . . . . . . . . 2-26

black and white display soft key  . . . . . 6-9
black plug body . . . . . . . . . . . . . . . . . . 2-29
block diagram

tower mounted amplifiers  . . . . . . . D-1
brightness setting submenu key  . . . . 6-10
brightness soft key . . . . . . . . . . . . . . . . 6-9

C
calibration

before field measurement  . . . . . . . 1-8
cal lost, frequency changes  . . . . . . C-9
cautions . . . . . . . . . . . . . . . . . . . . . . 1-8
changes not allowed . . . . . . . . . . . . C-9
error messages . . . . . . . . . . . . . . . . C-9
file security, option 7  . . . . . . . . . . . 4-6
recommendation . . . . . . . . . . . . . . . 1-8
requirements  . . . . . . . . . . . . . . . . . 1-8
setup for option 7 . . . . . . . . . . . . . . 4-2
status in trace display . . . . . . . . . 2-10
warm up for accuracy . . . . . . . . . . . 2-2
waveguide components  . . . . . . . . 2-22

cautions
approved batteries . . . . . . . . . . . . . 1-9
approved batteries and chargers . 2-30
automotive 12 VDC adapter  . . 1-9, 2-1
ESD damage . . . . . . . . . . . . . . 1-8, 1-10
factory default or master reset  . . . 6-8
master reset and user data 2-31, C-1, C-2
use of phase stable Cable . . . . . . . . 1-8

center frequency sharing  . . . . . . . . . . 6-12
change directory . . . . . . . . . . . . . . . . . . 5-9
change file type . . . . . . . . . . . . . . . . . . . 5-9
charging battery symbol . . . . . . . . . . . 2-29
charging the battery . . . . . . . . . . . . . . . 1-9
coaxial cable, ESD cautions . . . . . . . . 1-10
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care  . . . . . . . . . . . . . . . . . . . . . . . . 2-27
50 ohm, port 1 . . . . . . . . . . . . . . . . 2-26
50 ohm, port 2 . . . . . . . . . . . . . . . . 2-26
bias input  . . . . . . . . . . . . . . . . . . . 2-26
Ext Freq Ref  . . . . . . . . . . . . . . . . . 2-25
external power  . . . . . . . . . . . . . . . 2-25
function overview . . . . . . . . .2-20, 2-21
GPS antenna (SMA) . . . . . . . .2-28, 7-1
headset  . . . . . . . . . . . . . . . . . . . . . 2-26
identifying on VNA Master  . . . . . . 1-4
LAN . . . . . . . . . . . . . . . . . . . . . . . . 2-22
preventive maintenance . . . . . . . . . 1-8
RF detector . . . . . . . . . . . . . . . . . . 2-25
RF In . . . . . . . . . . . . . . . . . . . . . . . 2-28
SMA, GPS . . . . . . . . . . . . . . . . . . . 2-28
Type-K . . . . . . . . . . . . . . . . . . . . . . 2-26
Type-N  . . . . . . . . . . . . . . . . . . . . . 2-26
USB . . . . . . . . . . . . . . . . . . . . . . . . 2-24
waveguide-coax adapter . . . . . . . . 2-22

contacting Anritsu  . . . . . . . . . . . . . . . . 1-2
copy menu  . . . . . . . . . . . . . . . . . . . . . . 5-14
create folder . . . . . . . . . . . . . . . . . . . . . 5-10
custom language

settings lost with reset . . . . . . . . . . 6-8

D
date and time, system settings  . . . . . . 6-8
default colors soft key . . . . . . . . . . . . . . 6-9
default gateway

functions overview  . . . . . . . . . . . . . G-5
defaults

frequency blanking effect . . . . . . . . 4-6
delete

menu . . . . . . . . . . . . . . . . . . . . . . . 5-15
detector

RF detector interface  . . . . . . . . . . 2-20
RF, connector description  . . . . . . 2-25
RF, power monitor  . . . . . . . . . . . . . 3-1
RF, power monitor image . . . . . . . . 3-2

DHCP
LAN connection  . . . . . . . . . . . . . . . G-1

DHCP Ethernet address . . . . . . . . . . . 2-22
diagram, TMA . . . . . . . . . . . . . . . . . . . . D-1
disconnecting connectors  . . . . . . . . . . 2-27

display
overview of features . . . . . . . . . . . . 2-6
settings  . . . . . . . . . . . . . . . . . . . . . . 6-8
settings menu . . . . . . . . . . . . . . . . . 6-9
typical spectrum analyzer  . . . . . . 2-11
typical VNA  . . . . . . . . . . . . . . . . . . 2-6

documents, reference  . . . . . . . . . . . . . . A-1
Dynamic Host Configuration Protocol

see DHCP

E
EEPROM memory  . . . . . . . . . . . .2-31, 4-3
enabling Ethernet . . . . . . . . . . . . . . . . 2-22
ESD damage, cautions  . . . . . . . . . . . . 1-10
Ethernet

address functions overview  . . . . . 2-22
configuration . . . . . . . . . . . . . . 6-8, G-3
enabling  . . . . . . . . . . . . . . . . . . . . 2-22
IP address . . . . . . . . . . . . . . . . . . . . G-1
menu . . . . . . . . . . . . . . . . . . . . . . . . G-4

external trigger message  . . . . . . . . . . 2-30

F
factory defaults

custom language settings lost . . . . 6-8
factory defaults soft key . . . . . . . . . . . 6-11
file

management . . . . . . . . . . . . . . . . . . 5-2
menu . . . . . . . . . . . . . . . . . . . . . . . . 5-8
menu map . . . . . . . . . . . . . . . . . . . . 5-7
setup file, recalling . . . . . . . . . . . . 5-13
types, by extension . . . . . . . . . . . . . 5-1

file type menu . . . . . . . . . . . . . . . . . . . 5-11
firmware

update . . . . . . . . . . . . . . . . . . . . . . 6-15
updating  . . . . . . . . . . . . . . . . . . . . 6-11

flash memory, internal . . . . . . . . .2-30, 4-3
formatting USB memory device . . . . . 2-24
FR detector interface  . . . . . . . . . . . . . 2-20
frequency

external reference  . . . . . . . . . . . . 2-25
freq blanking menu image . . . . . . . 4-6
freq blanking, factory default  . . . . 4-6
freq blanking, file security . . . . . . . 4-5
freq blanking, main topic . . . . . . . . 4-5
freq blanking, system option . . . . 2-32
freq changes and calibration . . . . . C-9
secure data  . . . . . . . . . . . . . . . . . . . 4-1
VCO calibration  . . . . . . . . . . . . . . . C-4

frequency range  . . . . . . . . . . . . . . . . . . 1-3
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functions overview
battery charging power  . . . . . . . . 2-25
DHCP  . . . . . . . . . . . . . . . . . . . . . . 2-22
headset  . . . . . . . . . . . . . . . . . . . . . 2-26
IP address . . . . . . . . . . . . . . . . . . . 2-22
LAN . . . . . . . . . . . . . . . . . . . . . . . . 2-22
subnet mask . . . . . . . . . . . . . . . . . 2-22
USB . . . . . . . . . . . . . . . . . . . . . . . . 2-24

G
gateway

part of IP address, LAN . . . . 2-22, G-1
general instrument specs

battery  . . . . . . . . . . . . . . . . . . . . . . 1-9
calibration . . . . . . . . . . . . . . . . . . . . 1-8
ESD damage . . . . . . . . . . . . . . . . . 1-10
maintenance . . . . . . . . . . . . . . . . . . 1-8
verification  . . . . . . . . . . . . . . . . . . . 1-8

GPS
activating  . . . . . . . . . . . . . . . . . . . . 7-1
antenna . . . . . . . . . . . . . . . . . . . . . . 7-1
icon, green . . . . . . . . . . . . . . . . . . . 2-29
icon, red  . . . . . . . . . . . . . . . . . . . . 2-29
option 31, main topic  . . . . . . . . . . . 7-1

H
hard key (main menu key) . . . . . . . . . 2-13
headset jack  . . . . . . . . . . . . . . . . . . . . 2-26
high contrast

soft key  . . . . . . . . . . . . . . . . . . . . . . 6-9
hold message, VNA Master  . . . . . . . . 2-30

I
icon

battery symbol  . . . . . . . . . . . . . . . 2-29
GPS . . . . . . . . . . . . . . . . . . . . . . . . 2-29
red plug body  . . . . . . . . . . . . . . . . 2-29
shift key  . . . . . . . . . . . . . . . .2-12, 2-29

impedance soft key . . . . . . . . . . . . . . . . 6-7
instrument mode  . . . . . . . . . . . . . . . . 2-19
internal flash memory  . . . . . . . . .2-30, 4-3
invert black and white display soft key 6-9
IP address . . . . . . . . . . . . . . . . . . . . . . . G-1

setting . . . . . . . . . . . . . . . . . . . . . . 2-22

K
K connector care . . . . . . . . . . . . . . . . . 2-27
K connector, RF In port  . . . . . . . . . . . 2-28
K connector, VNA ports  . . . . . . . . . . . 2-26
keys

front panel keys  . . . . . . . . . . . . . . 2-12
soft key types  . . . . . . . . . . . . . . . . 2-13

L
LAN connection  . . . . . . . . . . . . . 2-22, G-1
language

submenu key description . . . . . . . . 6-8
LED, Bias Status  . . . . . . . . . . . . . . . . 2-26
line of sight, GPS  . . . . . . . . . . . . . . . . . 7-1
Line Sweep Tools  . . . . . . . . . . . . . . . . . 8-3
links

contacting Anritsu . . . . . . . . . . . . . 1-2
MS20xxC product page  . . . . . . . . . 1-2

list box
select file type . . . . . . . . . . . . . . . . 5-11

LST. See Line Sweep Tools

M
main menu key (hard key) . . . . . . . . . 2-13
maintenance, preventive  . . . . . . . . . . . 1-8
master reset

custom language settings lost . . . . 6-8
instructions . . . . . . . . . . . . . . . 2-31, 4-4

master reset soft key  . . . . . . . . . . . . . 6-11
Master Software Tools  . . . . . . . . . . . . . 8-3
meas gain range menu . . . . . . . . . . . . . 6-6
meas gain range soft key  . . . . . . . . . . . 6-5
measurement

accuracy  . . . . . . . . . . . . . . . . . . . . . 1-8
display 4 traces (image) . . . . . . . . . 2-7
display image . . . . . . . . . . . . . . 2-4, 2-6
power monitor, dBm or watts  . . . . 3-1
storing . . . . . . . . . . . . . . . . . . . . . . 2-24

measurement guides, list . . . . . . . . . . . A-1
memory

EEPROM  . . . . . . . . . . . . . . . . 2-31, 4-3
flash, internal . . . . . . . . . . . . . 2-30, 4-3
profile and security  . . . . . . . . 2-30, 4-3
RAM  . . . . . . . . . . . . . . . . . . . . 2-31, 4-3
USB . . . . . . . . . . . . . . . . . . . . . 2-31, 4-3
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menu
application options . . . . . . . . . . . . . 6-3
application options, SPA  . . . . . . . . 6-7
application options, VNA . . . . . . . . 6-5
copy . . . . . . . . . . . . . . . . . . . . . . . . 5-14
delete . . . . . . . . . . . . . . . . . . . . . . . 5-15
display settings . . . . . . . . . . . . . . . . 6-9
Ethernet  . . . . . . . . . . . . . . . . . . . . . G-4
file  . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8
file type . . . . . . . . . . . . . . . . . . . . . 5-11
meas gain range . . . . . . . . . . . . . . . 6-6
options, system . . . . . . . . . . . . . . . . 6-8
power on  . . . . . . . . . . . . . . . . . . . . 6-13
preset  . . . . . . . . . . . . . . . . . . . . . . 6-14
recall  . . . . . . . . . . . . . . . . . . . . . . . 5-13
reset . . . . . . . . . . . . . . . . . . . . . . . . 6-11
save . . . . . . . . . . . . . . . . . . . . . . . . . 5-9
save location . . . . . . . . . . . . . . . . . 5-10
save on ...  . . . . . . . . . . . . . . . . . . . 5-12
system . . . . . . . . . . . . . . . . . . . . . . . 6-4
system group . . . . . . . . . . . . . . . . . . 6-2
system options  . . . . . . . . . . . . . . . . 6-8
system options 2/2  . . . . . . . . . . . . 6-12
system options, display  . . . . .6-9, 6-10
time domain options . . . . . . . . . . . . 6-6

menu map
file  . . . . . . . . . . . . . . . . . . . . . . . . . . 5-7

mode selection . . . . . . . . . . . . . . . . . . . 2-19
MS20xxC product page (URL) . . . . . . . 1-2
MST. See Master Software Tools

N
N connector care . . . . . . . . . . . . . . . . . 2-27
name (for instrument), system settings 6-8
night vision

soft key  . . . . . . . . . . . . . . . . . . . . . . 6-9

O
operating mode  . . . . . . . . . . . . . . . . . . 2-19
option

07, no access to USB memory  . . . . 4-3
2, time domain  . . . . . . . . . . . . . . . 2-32
31, GPS . . . . . . . . . . . . . . . . . . . . . . 7-1
5, power monitor . . . . . . . . . . . . . . . 3-1
7, calibration setup . . . . . . . . . . . . . 4-2
7, no access to internal memory  . 2-31
7, secure data operation . . . . . . . . . 4-1

options (system options)
display menu  . . . . . . . . . . . . . . . . . 6-9

P
panel, keys on front panel  . . . . . . . . . 2-12
password

submenu key description . . . . . . . 6-12
phase stable cable, caution . . . . . . . . . . 1-8
plane of calibration

reference plane extension values . . 2-9
plug body

black icon  . . . . . . . . . . . . . . . . . . . 2-29
plug body, red icon  . . . . . . . . . . . . . . . 2-29
Port 1, 50 ohm . . . . . . . . . . . . . . . . . . . 2-26
Port 2, 50 ohm . . . . . . . . . . . . . . . . . . . 2-26
port, enabling Ethernet  . . . . . . . . . . . 2-22
power

external . . . . . . . . . . . . . . . . . . . . . 2-25
power-on cycle  . . . . . . . . . . . . . . . . 2-2
relative  . . . . . . . . . . . . . . . . . . . . . . 3-2
relative soft key, power monitor  . . 3-2
RF detector . . . . . . . . . . . . . . . . . . 2-25
supply failure  . . . . . . . . . . . . . . . . . C-7

power meter measurement guide  . . . . A-1
power monitor

attenuation . . . . . . . . . . . . . . . . . . . 3-1
display (image) . . . . . . . . . . . . . . . . 3-3
menu . . . . . . . . . . . . . . . . . . . . . . . . 3-3
Option 5, main topic . . . . . . . . . . . . 3-1
relative soft key  . . . . . . . . . . . . . . . 3-2
zeroing . . . . . . . . . . . . . . . . . . . . . . . 3-1

power offset sharing . . . . . . . . . . . . . . 6-12
power on menu  . . . . . . . . . . . . . . . . . . 6-13
power-on with power switch . . . . . . . . 2-32
preset

menu . . . . . . . . . . . . . . . . . . . . . . . 6-14
soft key  . . . . . . . . . . . . . . . . . . . . . 6-14

preventive maintenance . . . . . . . . . . . . 1-8
profile, memory profile and security  . . 4-3

R
RAM Memory  . . . . . . . . . . . . . . . .2-31, 4-3
recall menu  . . . . . . . . . . . . . . . . . . . . . 5-13
reference plane
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